HANDS-ON, INSTRUCTOR-LED
IT TRAINING COURSES

» Android, iOS, Objective-C, Swift, Xamarin
» C, C++ Programming

» HTMLS5, JavaScript, jQuery, Angular, Node.js
» Java, Java EE, EJB, Spring, Hibernate

We Build

» .NET Programming Competence

» PHP Programming, Perl Programming GUARANTEED
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Why Choose HOTT?

Your Source for Quality and Value

First-rate materials. Expert instructors. Small classes. Well-structured, challenging hands on exercises.
These are the critical elements of a truly effective training program - and the key reasons why Hands On
Technology Transfer (HOTT) should be your source for software skills training.

HOTT is dedicated to providing programming professionals like you with the skills and knowledge necessary
to enhance competency and productivity. Whether you are moving into a new technology or advancing your

current skill set, HOTT will provide you with an unparalleled learning environment.

»» Perspective

Task-Oriented, Cross-Platform Training

As an independent, dedicated training organization,
HOTT offers a practical, realistic and unbiased view
of competing technologies and products that you
won’t get at training centers authorized by a particular
software vendor. Our courses emphasize task-
oriented, not product-oriented training - training
that integrates technologies the way your business
does. Because our instructors have cross-platform
knowledge and experience, you’ll get the full picture
- not just how to use a particular tool, but the issues
involved in using multiple tools in today’s open
environments, including practical design,
architecture, and coding issues. You’'ll understand
technology well enough to create good designs
before you code - and be prepared to design for a
client/server, cross-platform ormulti-tierenvironment.
HOTT prepares you to become a more knowledgeable,
efficient, effective, and valuable employee, as well as
a more educated technology consumer.

»» Convenience

Convenient Locations Save You Time and Money

HOTT offers courses at frequent intervals in a
number of cities across the United States to help
provide a location convenient to you. Easy access
helps you minimize your travel time and expenses as
well as down time from your job. There’s no financial
penalty if you have to withdraw or change your plans
after you register, so you can reserve your place as
early as you’d like. And registration’s as easy as
reaching for the phone.

"This is my second HOTT class. The
instructors, materials, and experience are
excellent. Best training I've had in both cases.
Highly recommend this company”

- B.G., Vulcan Materials Company

> > Quality

Skilled Instructors Who Are Professionals in Their
Fields

In addition to being seasoned professional trainers,
our instructors also have many years of training and
industry experience working in their respective
fields. Practiced developers, software engineers, and
system administrators, they understand the
challenges you face in your job and have first-hand
knowledge of the skills you need to succeed.

Extensive national and international teaching
experience has prepared our instructors to manage a
variety of group dynamics and relate to foreign
students, ensuring all participants’ full involvement
and success.
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»» Substance

Small Class Sizes, Exceptional Curriculum and
Courseware

HOTT class sizes are kept significantly smaller than
classes at other national training firms in order to
provide you with more personalized attention, more
focused content, and greater access to instructors for
problems and questions. We continually refine and
upgrade our courseware to reflect new product
features and industry requirements. Equally
important, we’ve built our curriculum to reflect the
needs of our students as they have communicated
them to us. As a result, you don’t just learn what we
think you should learn, you learn what other
professionals like you have identified as necessary to
their jobs.

You’ll find HOTT labs exceptionally challenging.
Their objective is to provide an in-depth, hands on
experience that replicates real work experience and
trains you to deal with the complexities of real
scenarios. With an average class size of under 12
students, you’'re assured full attention from the
instructor.

Course materials, including student and lab guides
and your lab software, are yours to keep. Certain
courses also include a complimentary industry
textbook, which provides additional supporting
information and reference material.

»» Selection

Dozens of Classes to Choose From

HOTT’s extensive offerings include introductory and
advanced courses in .NET, Java, SQL Server, UNIX/
Linux, Mobile Development, Windows Administration,
Web Programming, and more. Because we focus on
advanced programming skills, you'll find a greater
selection of advanced courses at HOTT than at most
other training centers. An even greater array of
highly focused courses are available for delivery at
your site.
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»» Value

Enjoy Superior Training at Significantly Lower Cost

HOTT delivers high-quality training, with all the
benefits of small-size classes, at highly competitive
prices. Special rates for large groups attending our
public classes save you even more.

And if you're in a remote location our fixed cost
travel packages allow you to simultaneously save
money and fix your budget.

For extensive individual needs, HOTT’s Training Pass
provides an extremely cost-effective option. And we
can often charge far less than you’d think to bring a
tailored program right to your facility. Call 1-800-
413-0939 for details on these options.
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"The hands on approach is great. | was able to
experiment with ideas to see how things work
in addition to the lab work. | would definitely
take a class from HOTT again.”

- B.G, Giant Eagle

"l thought the training was well organized and
structured with lots of labs/activities. The labs
really helped explain the logic from the lectures.
| thoroughly enjoyed the training and wouldn't
hesitate to attend more."

-C.D., NCHUKLTD




The HOTT Advantage

Critical Characteristics of Excellent Software Skills Training

Task-Oriented, Competency-Based Course Design

The best way to assure competency through training is to determine what tasks the trainees need to perform
in their job, and have them actually perform those tasks during the training. HOTT's course design and
development process begins with a task-orientation focused on creating true competency, and our small class
sizes assure that instructors can focus course content to your specific needs. The best way to assure
competence is through facilitated hands on practice. Our students spend at least 50% of their time in class
performing structured hands on lab exercises that build competence, confidence, and clarity. Our courses
never teach to certification tests - they focus on competency, because competent people will pass the
certification tests.

A Truly Hands On Learning Experience - At Least 50% Lab Time

People learn by doing. Educational psychologists generally agree that we learn and remember 80% of what
we experience or practice, versus only 10-20% of what we read or hear. Even the most ardent suppliers of
e-learning programs admit that instructor-led training is at least 20% more effective in meeting learning goals
and achieving retention. For this reason, HOTT courses are always designed to spend at least half of the class-
time working hands on with the technologies. And our small class sizes assure substantial interaction and
facilitation by your instructor.

HOTT’s hands on labs include comprehensive problem solving exercises. To facilitate and accelerate the
development of quality solutions, students work in teams with active involvement by the instructor. Studies
show social interaction and sharing of information ensure faster progress and greater retention. This method
of learning allows the instructor ample time to deliver relevant assistance and provide insight at each lab
station. The net result is a more complete and engaging learning experience.

Courseware Ownership and Control

Many training providers, even some of the largest ones, often concentrate first on winning the business, and
then on finding an instructor and placing responsibility for providing courseware on that instructor. These
"virtual" training providers own no courseware and have no course developers on staff. This is the best-kept
secret of the technical training industry. Too few customers ask the question, "Do you own and control your
courseware?" Since control of courseware offers so many advantages, virtual training providers cannot hope
to provide any guarantee of total success.

We control our own courseware to provide first rate support for presentations. Our student guides and hands
on exercises are constantly updated and improved, using both direct feedback from students and the
instructors' own observations of what works best in the classroom.

Experts agree that intense hands on practice drives up competence and retention. That's why HOTT places
special emphasis on hands on exercises in each course that we deliver. Most leased courseware falls far short
in this area. It takes extra effort and substantial knowledge to create robust, well documented exercises.
Companies that offer courseware for lease need to provide exercises that appeal to the lowest common
denominator; furthermore leased courseware cannot assume that complex software setup will necessarily be
available to support competency-based labs. As a result, lab exercises in leased courses can border on the
trivial, and are rarely complete in the sense of exercising all the skills being taught.

Our ownership of most of the courseware we use also keeps our variable costs down. We hope you'll notice
that those cost savings are being passed on to you, our customers.

Finally, ownership of our courseware means that when we deliver training at your facility, we can focus the

presentation as appropriate, and at no extra charge to you. Our course library offers a broad range of materials
to support a variety of topics.

8 1-800-413-0939 | www.traininghott.com



Instructors with Extensive Experience, Not Just Certifications
We know that professionals want to learn from professionals. Our instructors are not new to programming,
nor are they new to the industrial training environment.

» Our instructors are cross-trained in multiple related technologies.
» They're not just one step ahead of the students.
» They know about and can contrast competing technologies.

» Audits of applicants show that less than 10% of all instructors teaching for our competitors meet our strict
standards. The remaining 90% lack the qualifications and experience to teach for HOTT.

Multiple, Convenient Training Locations Across North America and the United Kingdom
HOTT offers regularly scheduled open-enrollment classes at frequent intervals in more than 100 cities across
North America and the United Kingdom. You won't have to wait to get the training you need and chances are
you won't have to travel far to get it either. With HOTT's convenient schedule and multiple training locations
there is the potential to lower or even eliminate the travel portion of your training budget. When it comes to
IT training you should be in control of when and where you study and it is a major goal of ours to make sure
you have that control.

Small Class Size

One of the primary determinants of the success of instructor-led training classes [besides the competency of
the instructor] is the accessibility students have to ask questions, get help when they need it, and receive
appropriate guidance. Our open enrollment classes average less than 12 students. That means less
waiting around to receive help during lab, more time spent discussing relevant problem domains, and more
direct contact with the instructor. For many students it's very important to be able to discuss their specific
action plan and opportunities on the job to apply what they're learning. That's just not possible if there are 20
to 30 people in a public class.

A Cost-Effective, Total Solution

Most companies that require software skills training spend too much on it and don't get the full value that can
be realized. You can't leverage the advantages of great training without cost control. At HOTT we offer you
a cost-effective, total solution. Our prices for both open-enrollment and on site training classes are
among the lowest in the industry. The availability of open-enrollment classes in more than 100 cities plus
travel packages and on site training options help minimize or, in some cases, eliminate your travel costs. And,
you pay no additional fees for application, registration, or cancellation. Unlike HOTT, many training providers
charge unnecessary fees for cancellations or changes.

HOTT's cost-effective, total solution allows you to plan in advance and make changes if necessary without any
hassle and without any financial penalty. And our fixed-cost discounted travel options allow you to take a
course anywhere in North America at a fixed, predictable cost that's lower than tuition alone at other training
providers. That's true cost control and if you compare our cost structure to other quality technical training
programs, you'll find there is simply no comparison!

Superior Customer Service

HOTT's customer service is unparalleled in the IT training industry. Tailored discount packages allow you to
exploit our multiple locations if you have personnel dispersed across the country. And we offer tuition and
travel packages that cost less than tuition alone at our competitors. We'll even make the
arrangements for you.

If you require mentoring on a particular subject when you're through with class, our instructors are always
available to you for assistance. HOTT strives to make every student comfortable within their newly learned
skill-set. We want you to excel at your job when you're through with the training and when it comes to
certification we want you to pass your exams. If a student is not confident in their abilities after training with
HOTT, they also have the option to retake all or part of the course again for no additional charge. If a student
lacks confidence we will work with him or her to develop the understanding that leads to confidence as well
as competence.
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Discount Options

Multiple Discount Options Can Save You Upto 44%

Whether you have a large group to train at one location, or smaller numbers of staff spread throughout the
country, HOTT can prepare a custom discount program that will save you money. We guarantee it! If you have
a discount program with any other training provider, we will beat it. Call us anytime at 1-800-413-0939.

HOTT provides the most attractive discount opportunities in the industry — without sacrificing flexibility or
convenience. When we structure a program to save you money, you don't have to sacrifice these important
qualities!

Individual Training Pass Options

# Courses Total Cost Cost Per Course % Savings
2 $3,890 $1,945 22%
3 $5,190 $1,730 31%
4 $6,390 $1,598 36%
5 $7,390 $1,478 41%
6 $8,390 $1,398 44%

Small Group Training Discounts: Save up to 15%

If your company has three or more students interested in attending the same HOTT class then our small group
training discounts could save you as much as fifteen percent off the cost of tuition. We offer a 10% discount
for 3 or 4 students attending the same class on the same date and a 15% discount for 5 or more.

HOTT Versus the Competition

Company Course Days Cost

Hands On Technology Transfer SQL Server 2017 Administration 5 $2,495
Global Knowledge Administering Microsoft SQL Server Databases 5 $3,095
Learning Tree SQL Server Database Administration 4 $2,990

Our live training programs often wind up costing you less than non-interactive options such as web-based
training or other CBT approaches. We can provide you live, hands on, instructor-led training for under $1,200
per student week, at your facility or ours. You don't have to sacrifice real learning to achieve your budget
goals!

If you have a large group to train, we can split them up to save you headaches. Schedule the date you want
for training at your site. If some of your people can't make it, they can attend the same class as a public
seminar. This allows you to avoid pulling all of your critical personnel out of production at the same time. Extra
cost? Usually none! It's your choice. No company offers training in more cities. So you don't need to train all
of your staff at once to save. You may even be able to avoid flying people in from remote facilities if they can
attend a public class near their own site, thereby cutting travel expenses even further.
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HOTT Prepayment Options

Prepaid Stu- Discount Cost Per Cost For 5 Day
dent Weeks Student/Day Class

10 $24,950 15% $21,207 $424 $2,121

15 $37,425 20% $29,940 $399 $1,996

20 $49,900 25% $37,425 $374 $1,871

25 $62,375 30% $43,663 $349 $1,747

30 $74,850 35% $48,653 $324 $1,622

35 $87,325 40% $52,395 $299 $1,497

40 $99,800 40% $59,800 $299 $1,497

Many training providers are proud to save 25% on high volume arrangements. Savings of 20% to 40% are easy
to achieve with HOTT, even if you have relatively small groups of people. Whether your staff are at a single
location or spread throughout the country, we can structure a program that will get them trained conveniently
and inexpensively while minimizing travel. Only HOTT can integrate on site training with an extensive
schedule of public hands on seminars to provide an annual training plan that minimizes cost, minimizes travel,

and maximizes convenience.

Whether you have 5 students or 50, whether they attend singly or in groups, our prepaid voucher program
will save you 20% to 43%. Our Training Pass can save 43% of the cost of training for an individual staffer. Call
1-800-413-0939 to discuss your specific situation, and we will structure a program that will save you money.

You will either save money or receive more training for your fixed budget. It's your choice!

1-800-413-0939 | www.traininghott.com
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Travel Value Packages

Cost-Effective and Convenient Travel Solutions

Students from anywhere in the United States, Canada, Mexico, or Europe can register for a class and pay an
additional $600 to have HOTT cover airfare and overnight hotel accommodations required to attend the class.
Call for available dates and locations. Payment for this option must be received by HOTT 14 days in advance
of the class start date. Offer is subject to available airfare.

If airfare is not required students may opt to simply pay $300 and HOTT will cover your overnight hotel
accommodations for up to five nights. Payment for this option must be received at least one business day prior
to the start of class.

"Not only was the training excellent (materials,
facility and instructor). | was also impressed
with how HOTT handled my hotel reservation
and accommodations.”

- B.\W,, Texas Parks and Wildlife
"Another great class. Can't wait for the next

one. The travel package made this very
convenient for us."

- J.O., Charlotte Hungerford Hospital
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Training Locations

Regularly Scheduled Courses in more than 100 Cities Across the United States

AL - Huntsville

AR - Little Rock
AZ - Phoenix

AZ - Tucson

CT - Hartford

CT - New Haven
CT - Stamford

CA - Bakersfield
CA - Fresno

CA - Irvine

CA - Los Angeles
CA - Modesto

CA - Oakland

CA - Riverside

CA - Sacramento
CA - San Bernardino
CA - San Diego

CA - San Francisco
CA - San Jose

CA - Santa Monica
CA - Temecula

CO - Denver

DC - Washington
FL - Fort Lauderdale
FL - Jacksonville
FL - Miami

FL - Orlando

FL - Pensacola

FL - Sarasota

FL - Tampa

FL - West Palm Beach
GA - Atlanta

GA - Savannah

IA - Cedar Rapids
IA - Des Moines

ID - Boise

IL - Chicago

IL - Schaumburg
IL - Springfield
IN - Indianapolis
KY - Louisville

LA - Shreveport
MA - Boston

MA - Chelmsford
MA - Quincy

MA - Springfield
MA - Waltham
MA - Woburn

MA - Worcester
MD - Baltimore
MD - Columbia
MI - Detroit

MI - Lansing

MN - Minneapolis
MO - Kansas City
MO - St. Charles
MO - Springfield
NC - Charlotte
NC - Raleigh-Durham
NC - Winston-Salem
NE - Omaha

NH - Manchester
NH - Nashua

NJ - Jersey City
NJ - Newark

NJ - Princeton
NM - Albuquerque
NM - Las Cruces
NV - Las Vegas
NY - Albany

NY - Binghamton

NY - Buffalo

NY - Ithaca

NY - Manhattan
NY - Rochester
NY - Syracuse

OH - Cincinnati
OH - Cleveland
OH - Columbus
OH - Dayton

OK - Oklahoma City
OK - Tulsa

OR - Portland

PA - Harrisburg
PA - Philadelphia
PA - Pittsburgh

RI - Providence
SC - Charleston
TN - Memphis

TN - Nashville

TX - Austin

TX - Corpus Christi
TX - Dallas

TX - El Paso

TX - Fort Worth
TX - Houston

TX - San Antonio
UT - Salt Lake City
VA - Alexandria
VA - Fairfax

VA - Norfolk

VA - Richmond
VA - Williamsburg
WA - Seattle

WA - Spokane

WI - Milwaukee
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Training Delivery Options

HOTT offers live, instructor-led IT training courses. Regardless of how you attend training, our courses are
designed to spend at least 50% of class-time working with comprehensive hands on exercises.

Classroom

Attend training face-to-face in a classroom-based setting. We offer more than 100 locations across the United
States, Canada and the United Kingdom. For clients traveling to a course location, HOTT offers cost effective
Travel Packages.

Remote Attendance

HOTT offers a remote attendance option for students who are not located near a training location and are
unable to travel. Remote access students attend the same live training delivery as students in the classroom
and perform hands on exercises using the same equipment at their location. HOTT will ship course materials
including a PC and audio/video equipment to your home or office. Two-way video and audio communication
allows participation as close to "being there" as possible.

On-Demand Training

This training option allows you to complete courses from any device (PC, phone or tablet) at your own pace.
The courses combine video, hands-on lab exercises and one-on-one mentoring to learn as your schedule
allows.

On Site

If you're scheduling training for more than 5 or 6 people at your facility, you should consider on site training.
This focused, cost-effective training option can save you 25-30% or more compared to individual tuition prices.
Training at your facility allows us to zero in on your specific requirements and, since we own our courseware,
there is no extra charge for curriculum adjustments. On site training is available worldwide.

Group Training Prices

(Remote Live Delivery) e RER.

5-Day Courses 5 days / 35 hours $10,900 (up to 10 students)
plus $600 per student over 10

4-Day Courses 4 days / 28 hours $9,700 (up to 10 students)
plus $500 per student over 10

3-Day Courses 3 days / 21 hours $8,500 (up to 10 students)
plus $400 per student over 10

Group Training Prices at

Facility in Continental U.S. AT AT

5-Day Courses 5 days / 35 hours $12,900 (up to 10 students)
plus $600 per student over 10

4-Day Courses 4 days / 28 hours $11,200 (up to 10 students)
plus $500 per student over 10

3-Day Courses 3 days / 21 hours $9,900 (up to 10 students)
plus $400 per student over 10
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Remote Attendance

If you are unable to travel or are not located near a training location, remote attendance may be an option for
you. HOTT will ship course materials including a PC and audio/video equipment to your home or office.

» Remote access students attend the same live training delivery as students in the classroom.
» Two-way video and audio communication allows participation as close to "being there" as possible.

» Remote attendees benefit from the interactions between other students and the instructor, such as real-time
questions and answers, and have the opportunity to actively participate as well.

» The hands on lab equipment shipped to remote attendees is the same as that provided in the classroom.

» Via remote viewing and control software, the instructor can monitor your lab work and respond to any issues
during the exercises, in much the same way that the instructor monitors lab work in the physical classroom.

The combination of physical courseware and robust lab exercises, multiple video feeds from the classroom,
and the ability of the instructor to see and react to remote students during class all combine together to allow
for a satisfying and effective remote attendance experience for students. Remote students are able to stay
focused and interested on the subject matter, because they are able to easily and quickly communicate with
the instructor and other students, and get real-time assistance from each other and the instructor during
hands-on lab exercises.

If you are interested in receiving dates for this option, please contact us at 1-800-413-0939.

"l was very skeptical of remote classes and
feel that online classes have very little value. |
thought this would be like an online class, but
the remote experience was much better than

anonline class. "

- L.P,, Beckman Coulter
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On-Demand Training

Train on your own schedule and at your own pace with personal facilitation

On-demand training allows you to complete courses from any device (PC, phone or tablet) at your own pace.
The courses combine video, hands-on lab exercises and one-on-one mentoring to learn as your schedule
allows.

» Students receive electronic copies of the same course materials as our live courses, which include a student guide
and lab guide.

» Students view carefully edited course videos - perfected for on-demand viewing - which can be viewed as often as
needed on a smart phone, tablet or computer.

» Students perform the same hands-on lab exercises used in the classroom via remote control access to a dedicated
lab machine. This allows direct assistance during lab work.

» An instructor will be assigned to monitor progress and answer any questions throughout the training process.

Every course in our catalog is available on-demand for $1,495 per course.

Contact us at 1-800-413-0939 for more information about our on-demand training.
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Onsite Training

Bring Our Courses to Your Facility

On site training is a cost-effective solution for teams of more than 5 or 6 students. Training at your facility
allows us to zero-in on your specific learning requirements and, since we own our courseware, there is no
extra charge for curriculum adjustments.

Your Schedule - Our Training

We will work with you to get your company's training when and where you need it. You will work with our
Client Relations Manager and our Training Director to coordinate a convenient and flexible timetable. We can
provide our training to you with just a few weeks advance notice. Sometimes even sooner!

Personalized Touch
Once we schedule an instructor to teach at your facility, they will contact you approximately 10 days before
the first day of training to discuss your specific training needs. Our curriculum can be tailored to suit your
specific learning goals.

More Than One Classroom of Students
If you have a large group to train — many classrooms of students - we can work with you to arrange a
convenient training schedule that will quickly and conveniently train your entire team.

We understand that everyone may not be able to attend training at one specific time and one specific location.
You do not need to train your entire staff at once to save. You can arrange for your team to attend any of our
public classes. No IT training company offers courses in more cities.

HOTT offers unparalleled convenience and flexibility that avoids pulling all of your critical personnel out of
production at the same time.

Minimize Your Incidental Expenses
You tell us where you need your training. We will bring our curriculum to your classroom. Our quoted price is
all-inclusive: instructor travel, student guides, textbooks are included.

Free On Site Training Proposal
To receive a free on site course proposal, please visit: www.traininghott.com/Onsite-Contact.php If you need

immediate assistance, please call us at 1-800-413-0939.
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Unbeatable Guarantees

Guarantees to Assure Training Success

We provide you a suite of unbeatable success guarantees that other companies don't dare to offer. HOTT
presents the best quality and value available today. Our customer service policies and guarantees assure that
you get quality training when you want it, and at the lowest total cost available from any source. We want you
to get the architectural insight and accelerated learning path that you came for. Every time. If you're not
totally satisfied for any reason, simply withdraw before the second day of any class. Notify the instructor and
return all course materials and you will receive a 100% refund. But the guarantees don't stop there.

Our instructors are dedicated technology experts whose focus is helping you achieve your learning goals.
HOTT's requirements for instructor performance are so stringent that only 2% of professional instructors
currently teaching for competitors can even be considered for an interview when they submit their resume to
us. And less than half of those pass our screening and are ever offered a position with HOTT. Because of this
high standard of excellence, and the support we provide in the form of excellent materials, robust hands on
exercises, and internal processes that remove risk of failure, we can offer the following ironclad guarantees:

» HOTT guarantees small class sizes.

» HOTT guarantees quality instructors.

» HOTT guarantees competence.

» HOTT guarantees that training from HOTT will be more cost-effective than training from any other source.

» HOTT guarantees that students in open-enrollment classes are protected against cancellations and will be able to
receive desired training at the cost they expect and in the time frame they have planned.

» HOTT guarantees overall quality with a 100% money-back guarantee. If you're not totally satisfied for any reason,
simply withdraw before the beginning of the second day (or before completing 4 modules of an on-demand
training presentation). Return all course materials and receive a 100% refund.

We Build
Competence

GUARANTEED

50% Hands
On Labs
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Government Employees

Agencies We Have Trained
HOTT has worked with various federal and state agencies as well as federal contractors. Here are some that
have chosen HOTT to provide their IT training.

» BAE Systems > IRS

» Defense Finance and Accounting Services (DFAS) » Lockheed Martin

» Department of Defense » NASA

» Department of Employment » Naval Surface Warfare
» Department of Fish and Game » Northrup Grumman

» Department of Homeland Security » Raytheon

» Department of the Navy » Tinker AFB

» Department of Treasury » US Air Force

» Department of Veteran Affairs » US Army

SAM Information
DUNS: 926531260
Cage Code: 1CSE2 SYSTEM FOR AWARD MANAGEMENT

NAICS Codes:

511210 Software Publishers

611420 Computer Training

611430 Professional and Management Development Training

"HOTT definitely gets you involved into course
knowledge by giving 'hands on' training. A
great element of the course structure!”

- J.C.,, Department of Homeland Security "Material was well prepared, concepts were
well taught throughout the course and
enforced with in-depth discussion and lab. One
of the better taught technical classes taken."

- AM, New Mexico Department of Labor
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Terms and Conditions

Terms for Open Enrollment Courses

Tuition Payment and Refund Policy: HOTT accepts company check, electronic funds transfer (EFT) or
corporate credit card for payment. Tuition for open-enrollment courses is due in full prior to the start date of
the class, with the exception of students from government agencies for which we have a valid purchase order.

Tuition includes all course materials. If you're not totally satisfied for any reason, simply withdraw before the
beginning of the second day (or before completing 4 modules of an on-demand training presentation). Return
all course materials and receive a 100% refund.

No refunds are available once 4 or more modules of an on-demand course are completed. Prorated refunds
may be granted for live courses for withdrawals after the first day.

NH students must withdraw and/or request a refund in written format.
Cancellations and Changes: There are no cancellation fees.

Attendance Requirements: Students must attend each day of a course and successfully complete hands on
exercises in order to receive a certificate of completion. If a student wishes to retake any portion of live a class
that he or she completes, the student may do so within 12 months at no extra cost.

Intended Audience: Hands On Technology Transfer provides corporate sponsored IT training designed for
technology professionals who wish to quickly upgrade their computer skills. Previous education or experience
cannot be credited toward completion of HOTT courses.

Terms for On Site Training

For courses held at client sites, HOTT provides all student materials including student guides and necessary
textbooks. The client is responsible for providing the training venue including computer hardware and
software required for laboratory sessions. HOTT can provide equipment to support training at very reasonable
rates when required. Course delivery is scheduled by mutual agreement in accordance with the availability of
HOTT instructors and the requirements of the client corporation. Payment is due Net 15 of the final day of
each course delivery.

Additional Terms for New Hampshire Students
Students may file a grievance with Hands On Technology Transfer If the matter is not resolved, students may

contact the Office of Career School Licensing, Department of Education, 101 Pleasant St, Concord NH 03301,
603.271.6443.
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Privacy Policy

What information do we collect?

Hands On Technology Transfer (HOTT) collects information from you when registering for class, requesting a
brochure, or contacting us via our Web forms. Any of the information we collect from you may be used in one
of the following ways:

» To improve customer service (your information helps us to more effectively respond to your requests)
» To process transactions
» To communicate with you about other courses or offers that may be of interest to you

Do we disclose any information to outside parties?

Your information, whether public or private, will not be sold, exchanged, transferred, or given to any other
company for any reason whatsoever, without your consent, other than for the express purpose of delivering
the purchased product or service requested.
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»What delivery options do you offer?
Courses can be taken face-to-face, remote-live, on-demand or on-site at your facility.

»What course materials are included?
Course materials include student guide, hands-on lab manual and USB flash drive for examples and lab work.

» Do I receive a certificate after completing the training?
Students receive a certificate of completion at the end of class.

»Can I retake a course?
Students can retake any portion of a class that has been completed, within 12 months at no extra cost.

»Do I need to bring a laptop to class?
Computers are provided for in-class use. Students are welcome to bring their own laptops as well.

»>What times are the classes?
Face-to-face and remote-live courses typically run Monday - Friday, 9:00am - 5:00pm.

»What is the location of the classroom?

Locations in each city may vary over time as we attempt to select locations that provide the greatest mutual
convenience for registrants. If you need a specific address for a purchase order or any other reason, feel free
to call us.

»What are the qualifications of your instructors?

All of our instructors are experienced professionals; none has been teaching for less than a couple of years,
and most have been teaching for many years. The average technical experience of our instructor staff is over
ten years. Most of them have experience not only as technical instructors but as hands-on practitioners, so
they have real-world experience to go with their training experience.

»What is your refund policy?

If you're not totally satisfied for any reason, simply withdraw before the beginning of the second day (or before
completing 4 modules of an on-demand training presentation). Return all course materials and receive a 100%
refund. No refunds are available once 4 or more modules of an on-demand course are completed. Prorated
refunds may be granted for live courses for withdrawals after the first day.

»What if I need to cancel my class, reschedule or make a change to a participant?
You can cancel or reschedule at anytime. There are no registration fees or cancellation fees.

»>What types of payment do you accept?
Payment is not required at time of registration. However, payment is due in full prior to the start date of the
class. Your invoice will be e-mailed directly to you shortly after receipt of your registration.

We accept payment via company check, electronic funds transfer (EFT) or corporate credit card. If you would
like to pay via EFT or corporate credit card, please call 800-413-0939 after you receive an e-mail acknowledging
your registration. Checks should be mailed to:

Hands On Technology Transfer

1 Village Square, Suite 8
Chelmsford, MA 01824
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Object Oriented Analysis & Design with UML

Duration: 4 Days | Price: $2095

Students Will Learn:

» Extracting a system's requirements using a use-case model a problem domain
driven approach » Establishing metrics, peer reviews and heuristics to
» Leveraging the experience of experts by applying improve the quality of the object models

analysis and design patterns » Effectively documenting all phases of the software
» Defining a set of extensible, reusable software process using UML

classes (a class library) for the problem domain » Applying an iterative and incremental approach to
» Building interaction diagrams construction of software systems and components

» Defining a set of candidate classes that suitably

Course Description: This OOA&D training course presents the key concepts and methodologies required to
perform quality object-oriented software engineering, with particular attention to practical techniques such
as use-case and CRC analysis, UML diagramming, and patterns. Students practice applying object oriented
analysis during the course to improve software designs and to see how software objects can be altered to build
software systems that are more robust and less expensive. Students use several methods for analyzing
software systems, finding and refining useful classes and relationships between objects. Care is taken not to
focus on any one language so that all students can participate in the design exercises without relying on
specific programming skills. The course emphasizes the most practical analysis and design methods, including
the application of use case analysis, CRC analysis, problem domain analysis, activity diagramming, interaction
diagramming, and class diagramming.

The Unified Modeling Language (UML) is presented in detail and is used in the exercises and case studies.
Practical aspects of project management and implementation are presented from the perspective of
experienced object system designers. Special emphasis is given to the use of object patterns in developing
software systems. The students apply their skills in labs that are mini design sessions, during which the
instructor helps the students identify and overcome common obstacles that occur during group sessions.

Course Prerequisites: Knowledge of structured programming concepts.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Object-Oriented-Analysis-Design-Hands-On-Training-Course-Class-

Seminar-OOAD-OO.htm
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Learning to Program with Java™

Duration: 5 Days | Price: $2495

Students Will Learn:

» Fundamental elements of programming » Declaring and instantiating arrays
» Interactive Development Environment (IDE) » Using and creating interfaces
COMEEES » Defining classes using inheritance Exception
» Classes, objects and methods handling
» Declaring and instantiating a Java object » Formatting output with class Formatter
» Using conditional and looping constructs » Using strings, characters and regular expressions

Course Description: This hands on Java Programming course provides an introduction to programming
using the Java language. Students are introduced to the application development cycle, structure of programs,
and specific language syntax. The course introduces important algorithmic constructs, string and character
manipulation, dynamic memory allocation, standard I/O, and fundamental object-oriented programming
concepts. The course explains the use of inheritance and polymorphism early on so the students can practice
extensively in the hands on labs. Structured programming techniques and error handling are emphasized. The
course includes the processing of command line arguments and environment variables so students will be able
to write flexible, user-friendly programs. Comprehensive hands on exercises are integrated throughout to
reinforce learning and develop real competency.

This class is intended for non-programmers. Students who already understand fundamental structured
programming and object-oriented techniques should attend the Java Programming course instead of this more
introductory course.

Course Prerequisites: Familiarity with computers.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Learning-Java-Programming-Classes.htm
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Java™ Programming

Duration: 5 Days | Price: $2495

Students Will Learn:

» The advantages of using the Java platform » Writing multithreaded software

» How to code, compile and run standalone object- » Writing Java client/server software using TCP/IP
oriented Java programs networking

» Designing and writing Java classes suitable for a » Accessing and updating relational databases from
given application domain Java software

» Writing robust Java software that gracefully handles  » Writing and running servlets and JSPs

run—pme problems _ » Creating graphical user interfaces for Java software
» Coding Java programs using correct syntax and > Writing web-based applications in Java

block structure | ] I h s in th
» Using Java to read from and write to files ’ES;VS%\%%V;T?:% ;(ni?ta and use the tools in the

Manipulating files and directories in a platform-
neutral way

Course Description: This hands on course introduces experienced programmers to Java™ technology and
Java programming techniques. The Java platform provides an object-oriented, portable and robust framework
for application development. Included are core language concepts including fundamental data types, flow
control, and standard function libraries. The course emphasizes object oriented programming and modular
design to support distributed development environments. Included are the design of classes and objects,
inheritance and polymorphism, and the details about creating programs for use on a distributed network, with
emphasis on JSP, Servlets, and JDBC.The course also includes coverage of the Java Collections API, fundamental
I/O, exceptions, and exception handling. Students are introduced to GUI programming using the Swing library
as an example of a GUI API.

The course is designed to leverage the participants' existing programming skills and to highlight the new and
extended features of the Java programming framework as compared to other common languages.
Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency. Students who do not already possess fundamental programming skills should attend the Learning
to Program with Java course rather than this course.

Course Prerequisites: Basic programming skills in a structured language. Knowledge and experience with
Object-Oriented Design (OOD) is helpful, but not required

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Learning-Java-Programming-Classes.htm

"This class was all | hoped for and more! | didn't
expect to learn as much as | did in such a short
period of time. Leaving this class | am confident
that my future experiences with the Java
programming language will be productive and
effective.

- K.B., Marshall University
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Effectively Using Java™ Packages And Features

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Reflection and Introspection with Java Classes  » Processing Databases Using JDBC (java.sql
(java.lang.reflect package) package)

» Writing Type Safe and Reliable Code with the » Creating, Controlling, and Synchronizing Threads

Enhanced Capabilities of Java 5 » Creating and Using Inner and Nested Classes

» Using the Java Collections Framework (java.util » Using Networking Related Classes (java.net
package) package)

Course Description: This intermediate level course is intended for programmers who already have a
fundamental understanding of Java programming and some experience writing code. It provides additional
insights and details regarding some of the more advanced and useful capabilities contained in the Java
programming language and its associated packages. Topics include reflection and JavaBeans, Java 5 type
safety enhancements, the Java Collections Framework, Java Database Connectivity (JDBC), multithreading,
inner classes, and networking.

Course Prerequisites: Familiarity with and experience using Java. Completion of either the Learning to
Program with Java or Java Programming course, or equivalent Java programming experience.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Java-Packages-Training-Course.htm

"Excellent training class. And even better,
excellent instructor! The instructor did a great
job covering the required material. He used
real world examples to explain concepts and
to hold my atftention.”

— AY., Citizens Property Insurance
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Introduction to Web Application Development Using JEE,
Spring/Hibernate, Web Services and AJAX

Duration: 5 Days | Price: $2495

Students Will Learn:

» Java Web application architecture » Utilizing the Spring dependency injection framework
» Developing servlets and JSPs » Managing database operations by using the

» Consuming Web services Hilger.nate framew'ork. _ .
» Creating and deploying SOAP based and RESTful » Building Web applications by using the Spring MVC

Web services framework
i i Pt » Managing database transactions with Spring and
» Using JavaBeans in Web Applications Hiberoata

» Accessing databases with JDBC

» Effectively integrating Spring and Hibernate
» Importing and Utilizing JNDI Packages

> Integrating, testing and debugging AJAX functionality

Course Description: This course provides students hands on experience with cutting edge Java Enterprise
(Java EE) technologies, creating dynamic web and enterprise applications that utilize several Java frameworks
and technologies including JSP's and Servlets, Java Persistence API (JPA), JNDI, JDBC, AJAX, Web Services,
Spring and Hibernate. The goal is to enable students to exploit the Java EE platform and accompanying
frameworks to facilitate the development of distributed, web-enabled applications.

Students will architectural design issues as well as specific coding models for a variety of Java EE components.
By working with several Java frameworks in hands on labs, students will build applications that incorporate
many of the patterns commonly used in these and other Java frameworks. Upon completion of the course,
students should be able to learn and effectively utilize frameworks appropriate for their application
environment.

Starting with Java Server Pages and Servlets, the course then introduces some of the most widely used
frameworks to provide concrete illustrations of the services available. Since coding and deployment files are
standardized by the Java EE specifications, students may readily apply the skills learned in this class to write
code for any compliant server, including Apache Tomcat, JBoss, WebSphere, Oracle, WebLogic and many
others.

Students will learn how to utilize ANT, a flexible and powerful XML-based build utility, to compile, deploy and
execute stand-alone and enterprise Java applications. They will also use ANT to execute standalone client
applications that communicate with Java EE applications. Comprehensive hands on exercises are integrated
throughout to reinforce learning and develop real competency.

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. Fundamental knowledge of XML, HTML, and JavaScript is helpful but not required. HOTT's course
Java Programming or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Spring-Hibernate-AJAX-Training-Course.htm

28 1-800-413-0939 | www.traininghott.com


https://www.traininghott.com/Courses/Spring-Hibernate-AJAX-Training-Course.htm

Web Application Development Using Spring, Hibernate and JPA

Duration: 5 Days | Price: $2495

Students Will Learn:

» The core principles of Spring and of Dependency
Injection (DI)/Inversion of Control

» Using the Spring core module and DI to configure
and wire application objects (Beans) together

» Using the different types of metadata (XML, @
Component, and @Configuration)

» The complete capabilities of the core module

» Using the ORM (Object-Relational Mapping) module
to integrate Spring with technologies such as
Hibernate or JPA

» Spring's transaction support
» Integration of Spring with Java EE Web applications

» Structuring code using Hibernate protocols

» Using Hibernate Mapping to map persistent objects
to the database

» Working with collections and associations

» Using Hibernate's versioning support

» Mapping inheritance hierarchies using Hibernate
» Working with Hibernate Queries, HQL, and Criteria
» Hibernate transaction support

» The relationship between Hibernate and the Java
Persistence API (JPA)

» How to architect and code using JPA2

» The features and benefits of Hibernate

» How to architect applications using the Hibernate
framework

» Exploiting AJAX integration
» Exploiting Web services

Course Description: This course provides a comprehensive introduction to JPA (the Java Persistence API),
the Spring and Hibernate open source frameworks as well as Web Services and AJAX. Suitable for both
Spring3/Hibernate3 and Spring4/Hibernate4, the course includes coverage of the core Spring and Hibernate
capabilities, as well as the integration capabilities provided by Spring.

This Spring/Hibernate course introduces techniques for using the many new and powerful capabilities that
Spring4 supports. It includes complete coverage of the three main configuration styles (@Configuration, @
Component, XML), and guidelines for their usage. It also covers more advanced capabilities such as support
for JDBC and persistence frameworks like Hibernate, Spring declarative transactions, and Spring integration
with JEE Web technologies.

The course covers all important capabilities of the Hibernate open source object/relational persistence and
query service for Java. Coverage includes developing persistent classes in Java, as well as using associations/
relationships, inheritance, polymorphism, composition and collections. It also covers fundamentals of JPA (the
Java Persistence API) including JPA Annotations and JPQL (Java Persistence Query Language).

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency. Attendees build working Spring/Hibernate applications utilizing the Eclipse IDE, providing a
knowledge foundation applicable to all major development environments.

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. Fundamental knowledge of XML, HTML, and JavaScript is helpful but not required. HOTT's course
Java Programming or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Spring-Hibernate-Programming-Course.htm
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Introduction to Spring 5, Spring Boot and Spring REST

Duration: 5 Days | Price: $2495

Students Will Learn:

» Understanding the core principles of Spring, and of ~ » Customizing Boot's behavior with properties and in

Dependency Injection (D) / Inversion of Control other ways
» Using the Spring Core module and DI to configure » Working with the ORM (Object-Relational Mapping)
and wire application objects (beans) together module to integrate Spring with technologies such
» Knowing the different types of metadata as JPA
(XML, annotations/@Component, and Java » Using Spring Data to automatically generate JPA-
Configuration/@Configuration), and how and when based repository classes
to use them » Understanding and using Spring's transaction
» Understanding and using the complete capabilities support, including the easy-to-use Java annotation
of the Core module, such as lifecycle events, bean support
scopes, and the Spring API

» Understanding REST, and using Spring REST to build
» Using Spring Boot to simplify dependency RESTful services

managemer?t and conﬂguratlon _ . » Using Ajax-based front ends with Spring REST
» Understanding and using Boot's auto-configuration » Using RestTemplate to create Java REST clients

Course Description: Spring 5 provides an evolutionary advance of Spring's powerful capabilities. This
course introduces the many Spring Core capabilities, as well as providing guidelines on when and how to use
them. It also goes into considerable depth on Spring Boot for dependency management and auto-configuration,
as well as Spring REST for creating RESTful resources.

This course has been completely revised to utilize Spring Boot's easy configuration and auto-configuration
wherever possible. "Classic" Spring configuration (usually more verbose and complicated) is optionally
covered in abbreviated form.

The course starts with in-depth coverage of Spring's Core module to reduce coupling and increase the
flexibility, ease of maintenance, and testing of your applications. It goes on to cover many of the most important
capabilities of Spring, including easing configuration with Spring Boot, integrating JPA persistence layers with
Spring and Spring Data, and using Spring's declarative transaction capabilities.

The course includes a solid introduction to Spring REST, and coverage of building RESTful resources. It also
covers many of the details of Spring Boot, including how to create Boot-based POMs (maven) for simplified
dependency management, customizing Boot behavior, and understanding/managing Boot's auto-configuration.

Comprehensive hands on exercises are integrated throughout the course to reinforce learning and develop
real competency. This course will enable students to build working Spring applications with Java and will give
students an understanding of the important concepts and technology in a very short time.

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. Fundamental knowledge of XML is helpful but not required. HOTT's course Java Programming or
equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/Spring-5-Spring-Boot-Rest-Training-Course.htm
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Introduction to Spring 5, Spring MVC and Spring REST

Duration: 5 Days | Price: $2495

Students Will Learn:

» Understanding the core principles of Spring, and of module to integrate Spring with technologies such
Dependency Injection (D) / Inversion of Control as Hibernate or JPA

» Using the Spring Core module and DI to configure » Using Spring Data to automatically generate JPA-
and wire application objects (beans) together based repository classes

» Knowing the different types of metadata » Understanding and using Spring's transaction
(XML, annotations/@Component, and Java support, including the easy-to-use Java annotation
Configuration/@Configuration), and how and when support, as well as the tx/aop XML configuration
to use them elements

> UP%erstandingSnld usinrg] thele fcomp|>lete capa%ilities » Integrating Spring with Java EE Web applications
of the Core module, such as lifecycle events, bean » Buildin P ; ;
l g Web applications with Spring MVC,
scopes, and the Spring API including configuration using Java config and Servlet
» Using Spring Boot to simplify dependency 3 capabilities

management and configuration » Understanding and using the core capabilities of
» Working with the ORM (Object-Relational Mapping) Spring's Reactive programming support

Course Description: Spring 5 provides an evolutionary advance of Spring's powerful capabilities. This
course introduces these capabilities, as well as providing guidelines on when and how to use them. It includes
coverage of the three main configuration styles: Java-based (@Configuration), annotation-based (@
Component), and the traditional XML-based configuration that may still play an important role in existing and
new projects.

The course starts with in-depth coverage of Spring's Core module to reduce coupling and increase the
flexibility, ease of maintenance, and testing of your applications. It goes on to cover many of the most important
capabilities of Spring, including easing configuration with Spring Boot, integrating Hibernate and JPA
persistence layers with Spring and Spring Data, and using Spring's declarative transaction capabilities.

The course includes integration of Spring with Java EE Web applications, a solid introduction to Spring MVC,
and coverage of building RESTful resources with Spring MVC. It also provides an overview of Springs reactive
programming model for repositories and Web resources.

This course is hands on with labs to reinforce all the important concepts. It will enable you to build working
Spring applications and give you an understanding of the important concepts and technology in a very short
time.

The standard platform does all labs with the Eclipse IDE and the lab instructions include detailed directions
for setting up and using it. The course can be made available for all major development environments,
including IBM RAD and Intelli].

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. Fundamental knowledge of XML is helpful but not required. HOTT's course Java Programming
or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/Spring-MVC-5-Spring-Rest-Training-Course.htm
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Introduction to the Spring 5 Framework

Duration: 3 Days | Price: $1695

Students Will Learn:

» Understanding the core principles of Spring, and of  » Using Spring Boot to simplify dependency

Dependency Injection (D) / Inversion of Control management and configuration
» Using the Spring Core module and DI to configure » Working with the ORM (Object-Relational Mapping)
and wire application objects (beans) together module to integrate Spring with technologies such
» Knowing the different types of metadata as Hibernate or JPA
(XML, annotations/@Component, and Java » Using Spring Data to automatically generate JPA-
Configuration/@Configuration), and how and when based repository classes
to use them » Understanding and using Spring's transaction
» Understanding and using the complete capabilities support, including the easy-to-use Java annotation
of the Core module, such as lifecycle events, bean support, as well as the tx/aop XML configuration
scopes, and the Spring API elements

Course Description: Spring 5 provides an evolutionary advance of Spring's powerful capabilities. This
course introduces these capabilities, as well as providing guidelines on when and how to use them. It includes
coverage of the three main configuration styles: Java-based (@Configuration), annotation-based (@
Component), and the traditional XML-based configuration that may still play an important role in existing and
new projects.

The course starts with in-depth coverage of Spring's Core module to reduce coupling and increase the
flexibility, ease of maintenance, and testing of your applications. It goes on to cover many of the most important
capabilities of Spring, including easing configuration with Spring Boot, integrating Hibernate and JPA
persistence layers with Spring and Spring Data, and using Spring's declarative transaction capabilities. It also
covers integration of Spring with Java EE Web applications.

This course is hands on with labs to reinforce all the important concepts. It will enable you to build working
Spring applications and give you an understanding of the important concepts and technology in a very short
time.

The standard platform does all labs with the Eclipse IDE and the lab instructions include detailed directions
for setting up and using it. The course can be made available for all major development environments,
including IBM RAD and Intelli].

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. Fundamental knowledge of XML is helpful but not required. HOTT's course Java Programming
or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/Introduction-Spring-5-Training-Course.htm
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Introduction to Spring Boot 2

Duration: 3 Days | Price: $1695

Students Will Learn:

» Overview of Spring Core (focus on @Configuration)  » Understanding and using Spring Boot's Web

and Maven/Gradle capabilities
» When to use Spring Boot » Using embedded servlet containers
» Using Spring Boot starters and start.spring.io to » Using Spring Boot Data REST

easily create new applications

» Understanding and using Spring Boot's auto-
configuration

» Customizing your application configuration

» Using Spring Security with Spring Boot
» Understanding and using Spring Boot's Actuator
» Using Actuator endpoints to monitor and manage

J J d applications

» Understanding and using Spring Boot's Spring Data ; : ;

/ Spring Data JPA capabilities > Worklng it ST DEVIeE!S
» Spring CLI

Course Description: As the Spring framework has grown, creating and configuring Spring applications has
become more and more complex. Spring Boot takes an "opinionated" view of an application (via intelligent
defaults) that minimizes configuration and boilerplate Spring code. Spring Boot makes it easier to use Spring's
many frameworks, and adds advanced capabilities such as health monitoring. This course introduces Spring
Boot from the ground up, including overviews of building blocks such as Maven. It covers the key features and
capabilities of Spring Boot, and teaches experienced Spring developers the skills they need to use Spring Boot
productively. This course covers Spring Boot 2 and Spring 5 - the current releases of these frameworks.

The standard platform does all labs with the Eclipse IDE, and the lab instructions include detailed directions
for setting up and using it. The course can be made available for all major development environments,
including IBM RAD and Intelli].

Course Prerequisites: Java SE programming experience and an understanding of object-oriented design
principles. The course Java Programming or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:
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Analyzing and Presenting Data with Power BI

Duration: 3 Days | Price: $1695

Students Will Learn:

» The fundamentals and evolution of business tools to combine datasets for analysis
analysis processes and tools » How to modify relationships, cardinality, and cross
» The roles, tasks and tools involved in self-service filter direction to maximize the efficacy of analysis

business analysis

» How to connect to and import data from numerous
diverse sources into the Power Bl Desktop and

» Publishing to the Power Bl service

» Create and manipulating dashboards, reports and
apps in the Power Bl service

service
. » Refreshing datasets, reports and dashboards in the
> ?/rvnhpeor]rgtc)j:tlerzeCtly query data sources and when to Power Bl Desktop and service

» Sharing reports, dashboards, workbooks and
datasets in the Power Bl service

» Creating hierarchical drilldown reports
» Collaborating in the Power Bl service

» How to shape, transform, and combine data from
diverse sources to create useful reports

» Using the Power Query Editor
» Which visualizations are best suited for various

types of analysis » The basics of DAX (Data Analysis Expressions)
» How to create, organize and format visualizations » The utility of the Power Bl REST APl and the R, M
that evoke insight and deliver optimal impact and Python languages with regard to the Power Bl

» How to use and develop data models and related sulite of ools

Course Description: This course provides a robust and in-depth introduction to Microsoft's Power BI suite
of products. Students will learn to use the Power BI Desktop and Power BI online service to import, analyze,
and visualize business data, and to share business intelligence. Topics include an exploration of the evolution
of relational databases, data warehouse and business intelligence; importing and combining data from diverse
data sources; shaping and transforming data; modeling data; developing useful and insightful visualizations;
creating and sharing reports and dashboards in the Power BI service; collaborating in the Power BI service;
and an introduction to Data Analysis Expressions (DAX).

Students wanting in-depth coverage of DAX and Power Query M in addition to Power BI training should attend
the Analyzing Data with Power BI, DAX, and Power Query M course rather than this course.

Course Prerequisites: Before attending this Microsoft Power BI training course, students must have:

» High degree of computer literacy
» Experience with office applications
» Familiarity with spreadsheet functionality

» An understating of fundamental business analysis issues such as revenue, profitability, financial
accounting, and reporting

» Basic familiarity with relational databases and data warehousing is helpful but not required

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/Power-BI-Training-Course.htm
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Analyzing Data with Power Bl, DAX, and Power Query M

Duration: 5 Days | Price: $2495

Students Will Learn:

» The fundamentals and evolution of business » Create and manipulating dashboards, reports and
analysis processes and tools apps in the Power Bl service

» The roles, tasks and tools involved in self-service » Refreshing datasets, reports and dashboards in the
business analysis Power Bl Desktop and service

» How to connect to and import data from numerous  » Sharing reports, dashboards, workbooks and
diverse sources into the Power Bl Desktop and datasets in the Power Bl service
service » Creating hierarchical drilldown reports

» When to directly query data sources and when to P ;
import data » Collaborating in the Power Bl service

» How to shape, transform, and combine data from > laJ;gngoAd)éico 20 ey CallRiliens 1 e e eting

diverse sources to create useful reports ) ,
» Using the Power Query Editor > \?Jirtnhugkyg a Star data Schema from an OLTP source

- X)\,/Sécsho\ﬁ%?f;ggons are best suited for various » Fixing Data Granularity issues with DAX Calculations
» How to create, organize and format visualizations > B&%}”dmg ey Leviel) secuiiy Using [Row [H527S (7
that evoke insight and deliver optimal impact

» How to use and develop data models and related
tools to combine datasets for analysis

» How to modify relationships, cardinality, and cross
filter direction to maximize the efficacy of analysis

» Publishing to the Power Bl service

» Performing Transformations while loading data with
Power Query and M

» Using M language to write more powerful queries
than the standard Power Query user interface
allows

Course Description: This Power Bl Dax course provides a robust and in-depth introduction to Microsoft's
Power BI suite of products and gives students a solid understanding of data analysis with Power BI, DAX, and
Power Query M. Students will learn to use the Power BI Desktop and Power BI online service to import,
analyze, and visualize business data, and to share business intelligence. In addition, students will learn
beginner and intermediate techniques for adding calculations to their Power BI Data models using DAX, as
well as how to use the Power Query M language to write advanced queries in order to populate a data model
from external data sources.

Students who want Power BI training but do not need detailed coverage of DAX and Power Query M should
instead attend the shorter Analyzing and Presenting Data with Power BI course rather than this course.

Course Prerequisites: Before attending this Microsoft Power BI training course, students must have:

» High degree of computer literacy
» Experience with office applications
» Familiarity with spreadsheet functionality

» An understating of fundamental business analysis issues such as revenue, profitability, financial
accounting, and reporting

» Basic familiarity with relational databases and data warehousing is helpful but not required

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/Power-BI-Dax-Power-Query-M-Course.htm
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Website Development with HTMLS5, CSS and Bootstrap

Duration: 5 Days | Price: $2495

Students Will Learn:

» Creating a valid HTML document » Creating animations using transitions, transforms
» Using various tags to markup text and animations

» Creating and using CSS to format the appearance of > Displaying information using an HTML table
an HTML document » Including forms in an HTML document
» Using HTML5 semantic elements to define the » Validating forms using HTML5 features

structure of a page » Defining a CSS3 grid layout

» Changing the appearance of elementsin a ; ; ;
document with type, id, class and attribute selectors - retingvieien gl audio 9 @ L page
» Building a Web page using the Bootstrap grid

» Creating CSS3 effects such as drop shadows, text

shadows and using custom fonts syste.m .
» Creating ordered, unordered and description lists > colr{tsrlgé Elpo e 1o 5512 Tk, BUiens 2ne femm
> Displaying images on a Web page » Adding components to a page such as
» Creating hyperlinks using text or images dropdowns, thumbnails, alerts and glyphicons

» Using the a tag to create anchors in a page

Course Description: This hands on course provides a thorough introduction into the creation of a Website
using HTML, CSS and Bootstrap. The course starts with thorough coverage of HTML and Cascading Style
Sheets (CSS) and progresses to using the Bootstrap framework to create mobile-friendly websites.

Topics include use of HTML5 semantic tags, block-level and inline elements, creating links, ordered and
unordered lists, creation of tables and forms. Students will learn to attach CSS to a page using several
different techniques, CSS selectors and pseudo-classes, CSS box model, and a variety of CSS properties.
Students will learn how to create a Bootstrap page utilizing the grid system, implement commonly used
components (such as dropdowns and navigation bars), use Bootstraps CSS classes to format page elements
and use Bootstrap's plugins to add tabs, modals and accordions to a page.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Basic personal computer skills and basic Internet knowledge.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/HTMI -Bootstrap-Training-Course.htm
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JavaScript Programming

Duration: 5 Days | Price: $2495

Students Will Learn:

» Creating and using variables » Using the Document Object Model (DOM) to access
» Working with primitive data types th? HTML element§ o iE page dyham|c§lly
» Creating custom objects » Using JavaScript objects effectively, including the

. . window object and the navigator object
» Using event handlers to handle user-triggered » Performi tt tchi ith |
avants erforming pattern matching with regular

o ] ] ) expressions
» Defining and invoking functions

. i, » Validating a form
> Using cgndltlonal C,OHStrUCtS and loops » Using Geolocation and Web Storage JavaScript APls
» Debugging JavaScript code

. ) » Working with JSON objects
» Using arrow functions

. o » Using Ajax to make asynchronous calls to a Web
» Including JavaScript in a Web page server

Course Description: JavaScript is a scripting language that is commonly used to create and control dynamic
Website content along with its use in the Node.js runtime. This hands on JavaScript training course provides
the fundamental knowledge necessary to design and develop dynamic Web pages using JavaScript and to be
able to grasp JavaScript libraries and frameworks such as jQuery, React and Angular. Students will learn the
syntax of the JavaScript language and how to use JavaScript in a Web browser.

Topics include ways to declare variables, use of intrinsic JavaScript objects such as Math, Date and Array,
declaring and calling functions, defining custom objects, error handling, working with arrow functions, and
using conditional logic. Students will learn how to include JavaScript in a Web page and how to use browser-
based APIs such as the Document Object Model (DOM), Geolocation and Web Storage. Upon completion
students will be able to utilize event handling, form validation, JSON and Ajax.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Basic computer skills and knowledge of HTML fundamentals including use of
Cascading Style Sheets is recommended, but not required. The Website Development with HTML5, CSS
and Bootstrap course provides a thorough introduction into the creation of a Website using HTML and CSS.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/JavaScript-Programming-Training-Course.htm

"The instructor was great and the rule of three
helped me understand the material. You can't
beat: Talk about it. See it. Do it

- E.K,, Intersec Design
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jQuery Programming

Duration: 3 Days | Price: $1695

Students Will Learn:

» Referencing jQuery in a Page > Registering events in jQuery

» Selecting page elements using jQuery selectors > Setting CSS properties of page elements

» Selecting DOM elements using standard DOM » Making Ajax requests using the $.ajax function
methods » Changing the display style of an element using

» Creating and using jQuery plugins various effect methods

Course Description: jQuery simplifies client-side scripting via a series of open-source libraries that provide
frameworks for enhanced functionality. This hands-on course covers the jQuery library, DOM manipulation,
performing Ajax requests, and an overview of the UI library. Students will also learn how to use the jQuery
function to return a wrapped set of elements, use utility functions to work with arrays and strings, modify the
appearance of elements using a number of predefined effects as well as how to implement existing plugins.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency. Students who are not familiar with HTML5 and CSS3 should instead register for the course,
Developing Rich Internet Applications Using HTML5, CSS3 and jQuery.

Course Prerequisites: Knowledge of HTML5, CSS and JavaScript equivalent to attending the Website
Development with HTML5, CSS and Bootstrap and JavaScript Programming courses.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/jQuery-Programming-Course.htm
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Developing Mobile Websites with Responsive Web Design and
jQuery Mobile

Duration: 5 Days | Price: $2495

Students Will Learn:

» Designing and building a responsive Website jQuery Mobile

» Setting the viewport of a Website » Configuring jQuery Mobile using the mobileinit
» Writing CSS3 media queries event and the $ .mobile object

» Scaling images and media » Using layout grids to format page content
» Creating responsive navigation and layouts » Using the Panel widget to display a panel on a page

: : » Creating collapsible content blocks using the
> lrJeSslggr?s?\t/Z CSS and jQuery to create tables that are CoIIapsﬁﬂe and Collapsibleset widgets

» Creating a jQuery Mobile page » Building a responsive form using jQuery Mobile

e widgets
> Conf!gur!ng I e fuII-screeh 100]9%17S » Providing filter capability to a page using the
» Configuring a custom theme using Themeroller for Filterable widget

Course Description: This hands-on course conveys the fundamental skills necessary to design and build
responsive web sites for mobile devices such as phones and tablets. Attendees will use responsive web design
(RWD) techniques such as CSS3 media queries and flexible layouts to build mobile-compatible web sites.
Students will learn how to test mobile websites using emulators and simulators.

The course also provides an extensive introduction into using the jQuery Mobile Framework for building
mobile-specific web sites. Students will learn how to use jQuery Mobile widgets to create forms, lists, toolbars
and collapsible blocks. Students will also learn how to integrate SOA with a mobile web site including working
with RSS feeds, Google Maps integration and implementing server-side data access.

Attendees will use ThemeRoller for jQuery Mobile to download existing or custom theme swatches to format
the appearance of a web site. Additional topics include responding to user events, configuring jQuery Mobile
defaults and using page transitions. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency.

Course Prerequisites: Prior knowledge of HTML, CSS, JavaScript and jQuery equivalent to attending the
Website Development with HTML5, CSS and Bootstrap, JavaScript Programming and jQuery
Programming courses.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/jQuery-Mobile-Responsive-Web-Design-Training-Course.htm
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Developing Web Applications Using Angular

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using TypeScript and ECMAG to create components  » Using property binding to link DOM elements with

» Using directives and components to define Ul model data

elements, routes and screens » Building Single Page Applications using Angular
» Working effectively with component lifecycle events  » Integrating forms with Angular
» Injecting dependencies to lessen coupling and » Organizing code using modules

increase testability

» Unit testing Angular applications with Karma and
Jasmin

» Communicating with RESTful Web services

Course Description: This hands on programming course provides a thorough introduction to the Angular
JavaScript Framework including coverage of versions 2 through 6. Attendees will learn the fundamental skills
necessary to build Web Applications using Angular and the MVVM (Model-View-ViewModel) design pattern.
Topics include using TypeScript and ECMAScript 6 to create object-oriented Angular applications, extending
HTML by creating reusable Ul components, implementing data-binding, designing and using custom structural
and attribute directives, as well as creating and using Angular pipes for formatting and transforming data in
the UI. Students will explore creating UX's (User Experiences) by designing Web animations and implementing
both template-driven and reactive style forms. Students will learn to use Angular routing to create SPA's
(Single Page Applications). The course includes coverage of using DI (Dependency Injection) and Angular
services to provide business and data-access logic to the application, both locally as well as communicating
with RESTful web services to provide CRUD database operations.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

This course introduces Angular versions 2 through 6.
Course Prerequisites: Knowledge of HTML, CSS and JavaScript equivalent to attending the Website
Development with HTML5, CSS and Bootstrap and JavaScript Programming courses. Knowledge of

jQuery is helpful, but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Angular-Programming-Course.htm

42 1-800-413-0939 | www.traininghott.com


https://www.traininghott.com/Courses/Angular-Programming-Course.htm

React)S Web Application Development

Duration: 4 Days | Price: $2095

Students Will Learn:

» Rendering React Components » Using React Hooks

» Styling Components with CSS and Bootstrap » Single Page Applications with React Router
» Using Create React App » Validating Props with PropTypes

» Fetching External Data with Fetch API » Using Lifecycle Methods

» Leveraging JSX for Ul Design » Maintaining Component and Global State
» Creating Functional and Class-based Components > Registering Event Handlers

» Working with Forms » Animating React Components

Course Description: React (a.k.a. React]S or React.js) is a JavaScript library for developing user interfaces.
This hands-on React JS training course introduces students to the React JavaScript library and covers
essentials such as using Create React App, defining components, writing and styling JSX elements, passing
props, using state and registering event handlers. Students will also learn how to use React Hooks, the
Context API, Lifecycle Methods and how to implement global state using the Redux JavaScript library.

Comprehensive hands on exercises are integrated throughout to reinforce learning React JS and develop real
competency.

Course Prerequisites: Knowledge of HTML5, CSS, and JavaScript equivalent to attending the Website
Development with HTML5, CSS and Bootstrap and JavaScript Programming courses.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/React-Programming-Course.htm
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Node.js Application Development

Duration: 4 Days | Price: $2095

Students Will Learn:

» Installation and configuration of Node.js » Testing and Debugging Node.js applications

» Using npm to install and manage modules » Using Node.js core modules

» Working with the V8 Engine » Using the Node.js event system and event emitters
» Building HTTP servers and HTTP clients » Interacting with the file system using buffers and

streams

» Using Node.js networking API's to build
internetworked applications

» Creating and consuming RESTful Web services

» Synchronous and asynchronous design patterns
» Building Node.js applications
» Storing application data in NoSQL databases

» Working with Web application frameworks such as
Express

Course Description: This hands on Node.js course will teach front end designers and server side developers
how to rapidly create, maintain, and deploy Node.js applications. This course includes thorough coverage of
the Node.js architecture, the V8 engine and the Node Ecosystem. The course takes a practical approach to
creating and organizing Node.js applications using functions and modules as part of the Node.js organizational
structure. This course will provide attendees with a comprehensive understanding of Node.js core modules
and how to procure and install packages using npm. Attendees will learn to identify and correct problems
through unit testing and exception handling.

Attendees will learn how to use Node.js to create Command Line Interface applications for system
administration and process management, use Node.js networking modules to communicate with TCP/IP
clients and servers such as HTTP servers, and create / consume REST (Representational State Transfer) data
services. Attendees will learn how to leverage frameworks such as Express to rapidly build Web Applications.
Attendees will learn how to use Node.js to connect to NoSQL databases such as MongoDB to store, retrieve,
and manipulate data (i.e., achieve data persistence).

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Knowledge of JavaScript equivalent to attending the JavaScript Programming
course. Attendees should also have familiarity with a Windows, Linux, or OS X command line interface as well
as a basic understanding of network protocols such as HTTP.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Node-]S-Training-Course.htm
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Perl Scripting

Duration: 4 Days | Price: $2095

Students Will Learn:

» Writing Perl scripts constructs and loops
» Using Perl to read from and write to files » Creating hard and anonymous references
» Using arrays, hashes and scalars to create robust » Manipulating lists
Perl programs : ; :
. : . . ] » Debugging Perl scripts for optimum performance
> Using arithmetic, assignment, comparison and » Writing Perl scripts that process script arguments

logical operators in Perl
» Writing clear and concise regular expressions regular expressions

> Creating subroutines to promote cleaner code » Writing Perl Programs that access a Relational
» Controlling Perl program flow using conditional Database

» Implementing pattern matching in Perl scripts using

Course Description: This hands-on Perl Programming course presents a thorough introduction to the Perl
scripting language emphasizing the rapid development of portable and modular Perl programs and scripts.
Students are introduced to all major language elements including built-in data types, powerful operators, flow
control and robust built-in functions. The course also covers the use of command line processing, file and
directory I/O to create flexible and user friendly programs. Attendees will also be introduced to object-oriented
programming in Perl as well as how to use pattern matching with Regular Expressions and string handling
functions to manipulate files and data. Students will learn to create reusable code using subroutines, modules,
and Perl's object-oriented architecture to deploy business logic across many programs and scripts to enhance
maintainability and scalability.

Students will also learn to use the DBI Perl module to write programs that provide a consistent database
interface independent of the actual database being used. Comprehensive hands on exercises will be completed
throughout the course to reinforce key concepts and practice debugging techniques. Students are shown how
to extend Perl's basic functionality with packages and loadable modules.

Course Prerequisites: Prior scripting experience or knowledge of fundamental programming concepts.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Perl-Scripting-Classes.htm

"l loved the class. It was thorough and very
informative and a good combination of
lecture, examples, and hands-on. | would
definitely use HOTT again!"

- S.K,, Time Warner

45 1-800-413-0939 | www.traininghott.com


https://www.traininghott.com/Courses/Perl-Scripting-Classes.htm

PHP Programming

Duration: 5 Days | Price: $2495

Students Will Learn:

» Creating and modifying PHP pages hidden form fields and query strings

» Working with variables and data types » Using PHP to manipulate files

» Using if/elseif/else statements to control » Identifying and handling the three main types of
processing conditionally errors that can occur when programming with PHP

» Creating programs that include for, while, and do » The fundamental techniques necessary to create a
loops to process statements repeatedly shopping cart solution

» Employing the break, continue, and exit » Introduction to OOP (Object Oriented Programming)
statements to modify default loop behaviors in PHP

» Using and writing functions, including many new » Using an object-oriented API to access SQL to
PHP7 features such as type declarations, REST SELECT, INSERT, UPDATE and DELETE data from
parameters and argument unpacking tables

» Using PHP #include » Using the phpMyAdmin utility to administer the

MySQL database

» Creating arrays
» Manipulating strings in PHP using built-in functions
» Maintaining state using cookies, session variables,

» Using OOP in PHP to define and use classes

Course Description: This hands on PHP Programming course provides the knowledge necessary to design
and develop dynamic, database-driven Web pages using PHP 7. PHP is a language written for the Web, quick
to learn, easy to deploy and provides substantial functionality required for e-commerce. This course introduces
the PHP framework and syntax and covers in depth the most important techniques used to build dynamic Web
sites. Students learn how to connect to any modern database, and perform hands on practice with a MySQL
database to create database-driven HTML forms and reports.

E-commerce skills including user authentication, data validation, dynamic data updates, and shopping cart
implementation are covered in detail. Course elements include implementing RESTful servers for newer more
data driven sites. Students also learn how to configure PHP and the Apache Web Server.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Basic computer skills and knowledge of HTML fundamentals equivalent to attending
the Website Development with HTML5, CSS and Bootstrap course. Prior programming experience is
helpful but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/PHP-Programming-Training-Course.htm
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Python Programming

Duration: 4 Days | Price: $2095

Students Will Learn:

» Working with Python's built-in objects » Performing conversion operations on numbers
» Reading and writing files » Using conditional constructs to control flow of
execution

» Creating variables and objects in Python
» Communicating with databases » Writing clear and concise regular expressions

» Creating structured data with lists, tuples, sets and > Organizing code with functions and classes
dictionaries » Creating object-oriented Python programs

Course Description: This hands on Python programming course shows how to rapidly develop and maintain
effective Python programs. The course includes thorough coverage of Python syntax, built in data types and
control constructs. The course takes a practical approach to creating and organizing Python programs using
functions, packages, modules and classes as part of Python's object-oriented paradigm. Attendees will use
regular expressions to rapidly process data captured from users and from the file system.

Attendees will learn how to use Python to create scripts that manipulate data, automate tasks, perform error
handling and store and retrieve data by using relational databases. Students will be able to create Python
scripts that assist with system administration.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Prior scripting experience or knowledge of fundamental programming concepts.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Python-Programming-Course.htm
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Learning to Program with C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Designing and using classes

» Working with the .NET data types » Using arrays and .NET collections

» Creating variables with the proper scope and using ~ » Throwing and trapping exceptions using the C# try
operators to build complex expressions and catch statements

» Using control structures such as if, while and for » Using ADO.NET to access databases

» Using procedures to build complex applications » Working with files and directories

Course Description: This hands on C# programming course provides an introduction to programming using
the C# language. Students are introduced to the application development cycle, structure of programs, and
specific language syntax. The course also contains "Thinking Like a Programmer" sections that provide
students insight on how to develop common algorithms. The course covers console and file I/O, string and
character manipulation, managing data using collections and fundamental object-oriented programming
concepts. Error handling techniques are also emphasized. The course also introduces how to access databases
using ADO.NET and illustrates how to build user interfaces using Windows Forms. Comprehensive hands on
exercises are integrated throughout to reinforce learning and develop real competency.

Course Prerequisites: Familiarity with computers.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Learning-C-Sharp-Programming-Classes.htm

Small Class Size

HOTT's cost-effective, total
solution allows you to plan in
advance and make changes if

necessary without any hassle and
without any financial penalty.
And, you pay no additional fees
for application, registration, or
cancellation.
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Learning to Program with VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create VB.NET applications » Using procedures to build complex applications
» Working with the .NET data types » Designing and using classes
» Creating variables with the proper scope and using  » Using arrays and .NET collections

operators to build complex expressions » Throwing and trapping exceptions using the VB.NET
» Using control structures such as If, Do While and Try and Catch statements

RS » Using ADO.NET classes to access databases

Course Description: This hands on VB.NET programming course provides an introduction to programming
using the VB.NET language. Students are introduced to the application development cycle, structure of
programs, and specific language syntax. The course also contains "Thinking Like a Programmer" sections that
provide students insight on how to develop common algorithms. The course covers console and file I/O, string
and character manipulation, managing data using collections and fundamental object-oriented programming
concepts. Error handling techniques are also emphasized. The course also introduces how to access databases
using ADO.NET and illustrates how to build user interfaces using Windows Forms. Comprehensive hands on
exercises are integrated throughout to reinforce learning and develop real competency.

Course Prerequisites: Familiarity with computers.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Learning-VB-NET-Programming.htm

"The training exceeded my expectations. The
instructor was very knowledgeable. | plan to
use HOTT from here on out for my fraining
needs."

-S.S., CACI
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ASP.NET Web Forms Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Working with CSS in Web Forms
» Working with .NET data types » Using Web server controls to interact with users and
display data

» Creating variables with the proper scope

» Designing and using classes

» Using control structures

» Using procedures to build complex applications
» Throwing and trapping exceptions

» Using single and multi-dimensional arrays

» Working with .NET collections

» Using LINQ to make queries

» Creating event handlers to respond to control
events

» Validating input using ASP.NET validation controls

> Reusing design with master pages and user controls
» Managing state in a Web Forms application

» Using ADO.NET to interact with databases

» Using DataSets to read/write XML data

» Using Data Binding to display complex data on Web

» Defining and implementing interfaces Pages
» Working with enumerations » Using ASP.NET AJAX in Web Forms applications
» Creating ASP.NET Web Form applications » Deploying an ASP.NET Web application

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic Web sites with ASPNET Web Forms and the .NET Framework using C#. The class provides a
thorough introduction to the C# programming language, including coverage of the essentials of the C#
programming language, built in data types, operators, control structures, classes and methods, collections
and exception handling. Students then learn how to leverage the power of the .NET Framework to build Web
user interfaces. Students will learn use the power of ASPNET Web server controls combined with HTML5 to
design Web pages. They will use ASPNET Validation controls to provide both client-side and server-side data
validation for user input. Students will learn how to use master pages to enforce a consistent look and feel
across a set of Web pages, as well as how to use user controls to reuse smaller pieces of HTML across multiple

pages.

Students explore the complexities of state management in ASPNET Web Forms and how to use session and
view state objects to manage state between HTTP requests. Students spend time exploring how to use ADO.
NET to interact with databases by running SQL queries and executing stored procedures. They will also learn
how to read/write XML files using DataSets and DataTables. Students learn how ASPNET Web Forms data
binding to easily display data in list controls, the GridView control and the DetailsView control.

Microsoft provides support for Ajax-enabled Web Forms applications using the ASPNET AJAX Framework.
Students will learn how to use some of the server-side features to make asynchronous postbacks from the
browser, perform partial page updates using the UpdatePanel, use CSS to dim a page during postback and
use the Timer fetch data from the server asynchronously. Other topics include: using a Web.config file to
control application configuration; working with the query string; working with cookies; reading and writing
files; and deploying ASPNET web applications. Comprehensive labs provide the students with extensive
experience creating and deploying dynamic ASP.NET Web Form applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-Web-Forms-Programming-Course-Using-C-Sharp.htm
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ASP.NET Web Forms Programming Using Visual Basic.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create VB.NET applications » Working with CSS in Web Forms
» Working with .NET data types » Using Web server controls to interact with users and
» Creating variables with the proper scope display data hand| g I
P ; » Creating event handlers to respond to contro
» Designing and using classes events

» Using control structures

» Using procedures to build complex applications
» Throwing and trapping exceptions

» Using single and multi-dimensional arrays

» Working with .NET collections

» Using LINQ to make queries

» Validating input using ASP.NET validation controls

> Reusing design with master pages and user controls
» Managing state in a Web Forms application

» Using ADO.NET to interact with databases

» Using DataSets to read/write XML data

» Using Data Binding to display complex data on Web

» Defining and implementing interfaces Pages
» Working with enumerations » Using ASP.NET AJAX in Web Forms applications
» Creating ASP.NET Web Form applications » Deploying an ASP.NET Web application

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic Web sites with ASPNET Web Forms and the .NET Framework using VB.NET. The class provides a
thorough introduction to the VB.NET programming language, including coverage of the essentials of the
VB.NET programming language, built in data types, operators, control structures, classes and methods,
collections and exception handling. Students then learn how to leverage the power of the .NET Framework to
build Web user interfaces. Students will learn use the power of ASPNET Web server controls combined with
HTMLS5 to design Web pages. They will use ASPNET Validation controls to provide both client-side and server-
side data validation for user input. Students will learn how to use master pages to enforce a consistent look
and feel across a set of Web pages, as well as how to use user controls to reuse smaller pieces of HTML across
multiple pages.

Students explore the complexities of state management in ASPNET Web Forms and how to use session and
view state objects to manage state between HTTP requests. Students spend time exploring how to use ADO.
NET to interact with databases by running SQL queries and executing stored procedures. They will also learn
how to read/write XML files using DataSets and DataTables. Students learn how ASPNET Web Forms data
binding to easily display data in list controls, the GridView control and the DetailsView control.

Microsoft provides support for Ajax-enabled Web Forms applications using the ASPNET AJAX Framework.
Students will learn how to use some of the server-side features to make asynchronous postbacks from the
browser, perform partial page updates using the UpdatePanel, use CSS to dim a page during postback and
use the Timer fetch data from the server asynchronously. Other topics include: using a Web.config file to
control application configuration; working with the query string; working with cookies; reading and writing
files; and deploying ASPNET web applications. Comprehensive labs provide the students with extensive
experience creating and deploying dynamic ASP.NET Web Form applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-Web-Forms-Course-Using-VB-NET. htm
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ASP.NET Web Forms Programming for Experienced C#
Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating ASP.NET Web Form applications » Managing state in a Web Forms application
» Working with CSS in Web Forms » Using ADO.NET to interact with databases
» Using Web server controls to interact with users and  » Using DataSets to read/write XML data
display data » Using Data Binding to display complex data on Web
» Creating event handlers to respond to control Pages
M » Using ASP.NET AJAX in Web Forms applications

» Validating input using ASP.NET validation controls

» Deploying an ASP.NET Web application
» Reusing design with master pages and user controls

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic ASPNET Web Forms applications using C#. Students will learn use the power of ASPNET Web server
controls combined with HTML5 to design web pages. They will use ASPNET Validation controls to provide
both client-side and server-side data validation for user input. Students will learn how to use master pages to
enforce a consistent look and feel across a set of Web pages, as well as how to use user controls to reuse
smaller pieces of HTML across multiple pages.

Students explore the complexities of state management in ASPNET Web Forms and how to use session and
view state objects to manage state between HTTP requests. Students spend time exploring how to use ADO.
NET to interact with databases by running SQL queries and executing stored procedures. They will also learn
how to read/write XML files using DataSets and DataTables. Students learn how ASPNET Web Forms data
binding to easily display data in list controls, the GridView control and the DetailsView control.

Microsoft provides support for Ajax-enabled Web Forms applications using the ASPNET AJAX Framework.
Students will learn how to use some of the server-side features to make asynchronous postbacks from the
browser, perform partial page updates using the UpdatePanel, use CSS to dim a page during postback and
use the Timer fetch data from the server asynchronously. Other topics include: using a Web.config file to
control application configuration; working with the query string; working with cookies; reading and writing
files; and deploying ASPNET web applications. Comprehensive labs provide the students with extensive
experience creating and deploying dynamic ASPNET Web Form applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with C# is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-Web-Forms-Training-Using-C-Sharp.htm
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ASP.NET Web Forms Programming for Experienced VB.NET
Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating ASP.NET Web Form applications » Managing state in a Web Forms application
» Working with CSS in Web Forms » Using ADO.NET to interact with databases
» Using Web server controls to interact with users and » Using DataSets to read/write XML data
display data » Using Data Binding to display complex data on Web
» Creating event handlers to respond to control Pages
SIS » Using ASP.NET AJAX in Web Forms applications

» Validating input using ASP.NET validation controls

» Deploying an ASP.NET Web application
» Reusing design with master pages and user controls

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic ASPNET Web Forms applications using VB.NET. Students will learn use the power of ASPNET Web
server controls combined with HTML5 to design web pages. They will use ASPNET Validation controls to
provide both client-side and server-side data validation for user input. Students will learn how to use master
pages to enforce a consistent look and feel across a set of Web pages, as well as how to use user controls to
reuse smaller pieces of HTML across multiple pages.

Students explore the complexities of state management in ASPNET Web Forms and how to use session and
view state objects to manage state between HTTP requests. Students spend time exploring how to use ADO.
NET to interact with databases by running SQL queries and executing stored procedures. They will also learn
how to read/write XML files using DataSets and DataTables. Students learn how ASPNET Web Forms data
binding to easily display data in list controls, the GridView control and the DetailsView control.

Microsoft provides support for Ajax-enabled Web Forms applications using the ASPNET AJAX Framework.
Students will learn how to use some of the server-side features to make asynchronous postbacks from the
browser, perform partial page updates using the UpdatePanel, use CSS to dim a page during postback and
use the Timer fetch data from the server asynchronously.

Other topics include: using a Web.config file to control application configuration; working with the query
string; working with cookies; reading and writing files; and deploying ASPNET web applications.
Comprehensive labs provide the students with extensive experience creating and deploying dynamic ASPNET
Web Form applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with VB.NET is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-Web-Forms-Class-Using-Visual-Basic-NET.htm
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ASP.NET MVC Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Architecture of ASP.NET MVC web applications

» Working with .NET data types » Using Visual Studio to create Internet and Intranet
» Creating variables with the proper scope applications

» Designing and using classes » Creating controllers containing action methods to

) I process HTTP requests
- Ul EEe] SEEiEs » Using the ASPX and Razor view engines to design

» Using procedures to build complex applications views to render responses to HTTP requests

» Throwing and trapping exceptions » Creating data models by hand, by using typed

» Using single and multi-dimensional arrays datasets, and by using the Entity Framework

» Working with .NET collections » Creating and debugging ASP.NET MVC routines

» Using LINQ to make queries » Using MS Test and NUnit to create and run tests for

ASP.NET MVC applications

> Def|n.|ng ar.1d |mplemen‘F|ng LIEEIES: » Securing and deploying ASP.NET MVC web
» Working with enumerations applications

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic web applications using the ASPNET MVC 5 Framework and C#. The class provides a thorough
introduction to the C# programming language, including coverage of the essentials of the C# programming
language, built in data types, operators, control structures, classes and methods, collections and exception
handling.

Students learn how to leverage the power of the Model-View-Controller design pattern with the ASPNET MVC
Framework to separate the layers of a web application. Students will use the ASMX and Razor view engines
to design a user interface. Students will learn how to build models to manage an application's data layer using
both the Entity Framework and LINQ to SQL. And students will learn how to build controllers containing
action methods to manage communication between views and models.

Other topics include data scaffolding; URL routing; implementing security; using MVC and Web Forms in the
same application, unit testing; and deploying ASPNET MVC applications. Comprehensive labs provide the
students with experience creating, debugging, testing and deploying dynamic ASPNET MVC applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/MVC-Programming-Courses-Using-C-Sharp.htm
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ASP.NET MVC Programming Using VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create VB.NET applications » Architecture of ASP.NET MVC web applications

» Working with .NET data types » Using Visual Studio to create Internet and Intranet
» Creating variables with the proper scope applications

» Designing and using classes » Creating controllers containing action methods to

) I process HTTP requests
- Ul EEe] SEEiEs » Using the ASPX and Razor view engines to design

» Using procedures to build complex applications views to render responses to HTTP requests

» Throwing and trapping exceptions » Creating data models by hand, by using typed

» Using single and multi-dimensional arrays datasets, and by using the Entity Framework

» Working with .NET collections » Creating and debugging ASP.NET MVC routines

» Using LINQ to make queries » Using MS Test and NUnit to create and run tests for

ASP.NET MVC applications

> Def|n.|ng ar.1d |mplemen‘F|ng LIEEIES: » Securing and deploying ASP.NET MVC web
» Working with enumerations applications

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic web applications using the ASPNET MVC 5Framework and VB.NET. The class provides a thorough
introduction to the VB.NET programming language, including coverage of the essentials of the VB.NET
programming language, built in data types, operators, control structures, classes and methods, collections
and exception handling.

Students learn how to leverage the power of the Model-View-Controller design pattern with the ASPNET MVC
Framework to separate the layers of a web application. Students will use the ASMX and Razor view engines
to design a user interface. Students will learn how to build models to manage an application's data layer using
both the Entity Framework and LINQ to SQL. And students will learn how to build controllers containing
action methods to manage communication between views and models.

Other topics include data scaffolding; URL routing; implementing security; using MVC and Web Forms in the
same application, unit testing; and deploying ASPNET MVC applications. Comprehensive labs provide the
students with experience creating, debugging, testing and deploying dynamic ASPNET MVC applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-MVC-Programming-Courses-Using-VB-NET.htm

57 1-800-413-0939 | www.traininghott.com


https://www.traininghott.com/Courses/ASP-NET-MVC-Programming-Courses-Using-VB-NET.htm

ASP.NET MVC Programming for Experienced C# Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Architecture of ASP.NET MVC web applications » Creating data models by hand, by using typed

» Using Visual Studio to create Internet and Intranet datasets, and by using the Entity Framework
applications » Creating and debugging ASP.NET MVC routines

» Creating controllers containing action methods to » Using MS Test and NUnit to create and run tests for
process HTTP requests ASP.NET MVC applications

» Using the ASPX and Razor view engines to design » Securing and deploying ASP.NET MVC web
views to render responses to HTTP requests applications

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic web applications using the ASPNET MVC 5 Framework and C#. Students should already have a
working knowledge of C#.

This course teaches students how to leverage the power of the Model-View-Controller design pattern with the
ASPNET MVC Framework to separate the layers of a web application. Students will use the ASMX and Razor
view engines to design a user interface. Students will learn how to build models to manage an application's
data layer using both the Entity Framework and LINQ to SQL. Students will also learn how to build controllers
containing action methods to manage communication between views and models.

Other topics include data scaffolding; URL routing; implementing security; using MVC and Web Forms in the
same application, unit testing; and deploying ASPNET MVC applications. Comprehensive labs provide the
students with experience creating, debugging, testing and deploying dynamic ASPNET MVC applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with C# is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/MVC-Training-Courses-Using-C-Sharp.htm

“B est hands on class I've had. Instructor was
informative and entertaining, keeping me
funed in. Labs were excellent!

- T.D., Wise Foods Inc
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ASP.NET MVC Programming for Experienced VB.NET Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Architecture of ASP.NET MVC web applications » Creating data models by hand, by using typed

» Using Visual Studio to create Internet and Intranet datasets, and by using the Entity Framework
applications » Creating and debugging ASP.NET MVC routines

» Creating controllers containing action methods to » Using MS Test and NUnit to create and run tests for
process HTTP requests ASP.NET MVC applications

» Using the ASPX and Razor view engines to design » Securing and deploying ASP.NET MVC web
views to render responses to HTTP requests applications

Course Description: This course provides students with hands on experience using Visual Studio to create
dynamic web applications using the ASPNET MVC 5 Framework and VB.NET. Students should already have
a working knowledge of VB.NET.

This course teaches students how to leverage the power of the Model-View-Controller design pattern with the
ASPNET MVC Framework to separate the layers of a web application. Students will use the ASMX and Razor
view engines to design a user interface. Students will learn how to build models to manage an application's
data layer using both the Entity Framework and LINQ to SQL. Students will also learn how to build controllers
containing action methods to manage communication between views and models.

Other topics include data scaffolding; URL routing; implementing security; using MVC and Web Forms in the
same application, unit testing; and deploying ASPNET MVC applications. Comprehensive labs provide the
students with experience creating, debugging, testing and deploying dynamic ASPNET MVC applications.

Course Prerequisites: Knowledge of fundamental HTML syntax is helpful, but not required. Prior experience
with VB.NET is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-MVC-Training-Courses-Using-VB-NET.htm

Guarantees

We guarantee the quality of our
courses with a full 100% money-
back guarantee. We guarantee

quality instructors. We guarantee
competence. And we guarantee
that IT training from HOTT will be
more cost effective than training
from any other source.
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Introduction to ASP.NET Core MVC

Duration: 4 Days | Price: $2095

Students Will Learn:

» Gaining a thorough understanding of the using ASP.NET Core MVC
philosophy z.and architecture of .NET Core » Gaining a practical understanding of .NET Core
- WnelerEEneling [Pl EEes, MEEpReEEss i » Acquiring a working knowledge of Web application

frameworks development using ASP.NET Core MVC 6 and Visual
» Acquiring a working knowledge of the .NET Studio 2015

programming model » Persisting data with XML Serialization and ADO.NET
» Implementing multi-threading effectively in .NET with SQL Server 2014

applications » Creating HTTP services using ASP.NET Core Web API

» Gaining a thorough understanding of the
philosophy and architecture of Web applications

Course Description: This course is designed to provide an introduction to .NET Core for programmers who
already know the C# language. The course focuses on core portions of the .NET Framework that are common
across many application areas. It starts with an introduction to the architecture and key concepts of .NET. The
course then discusses class libraries, packages, metapackages and frameworks. Coverage includes working
with delegates and events, I/O and serialization, memory management, processes and threads as well as
threading and an introduction to the Task Parallel Library (TPL).

This course also provides a practical hands-on introduction to developing Web applications using ASPNET
Core MVC 6 and C#. This Web development framework from Microsoft emphasizes separation of concerns in
the architecture and testability of applications. This course covers the fundamentals of the Model-View-
Controller design pattern and its implementation in ASPNET Core MVC. After presenting the fundamentals
of the technology with several examples, the main components of Model, Controller and View are covered in
detail. The discussion of the Model incorporates Microsoft technologies for persisting data, including XML
Serialization and ADO.NET with SQL Server 2014. The routing mechanism of ASPNET MVC is covered. The
course includes an introduction to ASPNET Web APIL.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: C# programming experience.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/ASP-NET-Core-MVC-Training-Course.htm
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Windows Forms Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Creating desktop-based applications
» Working with .NET data types » Using control properties and methods to modify the
» Creating variables with the proper scope and using appearance and behavior of controls

operators to build complex expressions » Writing event handlers to respond to user
» Designing and using classes [EEFEODOrs
; . : » Using list-based controls such as ListBoxes and
> Us!ng control structuresl,lsuch asllf, WhllT- anq for ComboBoxes on forms
> L [PHeESeIVEs 0 [ovite] Gelimfples efpp it » Using image controls such as ImageList and

» Throwing and trapping exceptions using try and PictureBox on forms
catch statements

» Using single and multi-dimensional arrays
» Working with .NET collections

» Accessing and displaying data using ADO.NET
» Binding data to controls on a Windows Form
» Using modal and modeless dialogs to interact with

» Using LINQ to make queries users
» Defining and implementing interfaces » Using the background worker to perform an
» Working with enumerations asynchronous operation

Course Description: This course provides students with hands on experience using Visual Studio to create
desktop applications using Windows Forms and the .NET Framework using C#. The course provides a
thorough introduction to the C# programming language, including coverage of the essentials of the C#
programming language, built in data types, operators, control structures, classes and methods, collections
and exception handling.

Students then learn how to leverage the power of the .NET Framework to build desktop applications. Students
learn how to build Windows Forms applications and use with a variety of controls to create sophisticated user
interfaces. Students also learn how to use the BackgroundWorker to perform asynchronous operations.

Students also learn how to use ADO.NET to interact with databases and XML files. Students learn how
Windows Forms uses data binding to display data in controls such as the DataGridView and Chart. Students
will also learn how to leverage the power of web services by calling both SOAP services and RESTful APIs..
Other topics include: debugging techniques; using a .config file to control application configuration; building
menus, toolbars and status bars; reading and writing files; interacting with the file system; and deploying
desktop applications.

Comprehensive labs provide the students with extensive experience creating and deploying Windows Forms-
based desktop applications.

Course Prerequisites: Prior programming experience is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Windows-Forms-Training-Course-Using-C-Sharp.htm
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Windows Forms Programming Using VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create VB.NET applications
» Working with .NET data types

» Creating variables with the proper scope and using
operators to build complex expressions

» Designing and using classes
» Using control structures such as If, While and For
» Using procedures to build complex applications

» Throwing and trapping exceptions using the Try and
Catch statements

» Working with enumerations
» Creating desktop-based applications

» Using control properties and methods to modify the
appearance and behavior of controls

» Writing event handlers to respond to user
interactions

» Using list-based controls such as ListBoxes and
ComboBoxes on forms

» Using image controls such as ImageList and
PictureBox on forms

» Using single and multi-dimensional arrays
» Working with .NET collections

» Using LINQ to make queries

» Defining and implementing interfaces

» Accessing and displaying data using ADO.NET
» Binding data to controls on a Windows Form

» Using modal and modeless dialogs to interact with
users

Course Description: This course provides students with hands on experience using Visual Studio to create
desktop applications using Windows Forms and the .NET Framework using Visual Basic.NET. The course
provides a thorough introduction to the VB.NET programming language, including coverage of the essentials
of the VB.NET programming language, built in data types, operators, control structures, classes and methods,
collections and exception handling.

Students then learn how to leverage the power of the .NET Framework to build desktop applications. Students
learn how to build Windows Forms applications and use with a variety of controls to create sophisticated user
interfaces. Students also learn how to use the BackgroundWorker to perform asynchronous operations.
Students learn how to use ADO.NET to interact with databases and XML files. Students learn how Windows
Forms uses data binding to display data in controls such as the DataGridView and Chart..Students will also
learn how to leverage the power of web services by calling both SOAP services and RESTful APIs.

Other topics include: debugging techniques; using a .config file to control application configuration; building
menus, toolbars and status bars; reading and writing files; interacting with the file system; and deploying
desktop applications.

Comprehensive labs provide the students with extensive experience creating and deploying Windows Forms-
based desktop applications.

Course Prerequisites: Prior programming experience is required.
For a complete detailed course description, visit:

indows-Forms-Programming-Class.htm

http://www.traininghott.com/Courses
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Windows Forms Programming for Experienced C#
Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating desktop-based applications PictureBox on forms
» Using control properties and methods to modify the  » Accessing and displaying data using ADO.NET
appearance and behavior of controls » Binding data to controls on a Windows Form

> Writing event handlers to respond to user » Using modal and modeless dialogs to interact with
interactions i

» Using list-based controls such as ListBoxes and :
» Using the background worker to perform an
ComboBoxes on forms asynchronous operation
» Using image controls such as ImagelList and

Course Description: This course provides students with hands on experience using Visual Studio to create
desktop applications using Windows Forms and the .NET Framework using C#. Students should already have
a working knowledge of C#.

This course teaches students how to leverage the power of the .NET Framework to build desktop applications.
Students learn how to build Windows Forms applications and use with a variety of controls to create
sophisticated user interfaces. Students also learn how to use the BackgroundWorker to perform asynchronous
operations.

Students also learn how to use ADO.NET to interact with databases and XML files. Students learn how
Windows Forms uses data binding to display data in controls such as the DataGridView and Chart. Students
will also learn how to leverage the power of web services by calling both SOAP services and RESTful APIs.
Other topics include: debugging techniques; using a .config file to control application configuration; building
menus, toolbars and status bars; reading and writing files; interacting with the file system; and deploying
desktop applications.

Comprehensive labs provide the students with extensive experience creating and deploying Windows Forms-
based desktop applications.

Course Prerequisites: Prior experience with C# is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/C-Sharp-Windows-Forms-Training-Course.htm

"Great class. The instructor has an amazing
knowledge of many different programming
languages and can answer questions in a
precise and informative way. Lots of material
to cover. Time well spent and would definitely
come again. "

- E.P,, Autoliv
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Windows Forms Programming for Experienced VB.NET
Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating desktop-based applications PictureBox on forms
» Using control properties and methods to modify the  » Accessing and displaying data using ADO.NET
appearance and behavior of controls » Binding data to controls on a Windows Form

> Writing event handlers to respond to user » Using modal and modeless dialogs to interact with
interactions i

» Using list-based controls such as ListBoxes and :
» Using the background worker to perform an
Com QBoxes on forms . asynchronous operation
» Using image controls such as ImagelList and » Calling Web services

Course Description: This course provides students with hands on experience using Visual Studio to create
desktop applications using Windows Forms and the .NET Framework using Visual Basic.NET. Students should
already have a working knowledge of VB.NET.

This course teaches students how to leverage the power of the .NET Framework to build desktop applications.
Students learn how to build Windows Forms applications and use with a variety of controls to create
sophisticated user interfaces. Students also learn how to use the BackgroundWorker to perform asynchronous
operations.

Students also learn how to use ADO.NET to interact with databases and XML files. Students learn how
Windows Forms uses data binding to display data in controls such as the DataGridView and Chart. Students
will also learn how to leverage the power of web services by calling both SOAP services and RESTful APIs.

Other topics include: debugging techniques; using a .config file to control application configuration; building
menus, toolbars and status bars; reading and writing files; interacting with the file system; and deploying
desktop applications.

Comprehensive labs provide the students with extensive experience creating and deploying Windows Forms-
based desktop applications.
Course Prerequisites: Prior experience with VB.NET is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Visual-Basic-NET-Windows-Forms-Training-Course.htm
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Windows Presentation Foundation Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Creating and deploying a WPF application
» Working with .NET data types » Working with XAML
» Creating variables with the proper scope » Writing XAML markup to create controls, define

property values and setup events

» Using the WPF layout controls to build user
interfaces

» Writing event handlers

» Using predefined dialogs

» Creating and using custom dialogs

» Using brushes, shapes and animations within WPF

» Designing and using classes

» Using control structures

» Using procedures to build complex applications
» Throwing and trapping exceptions

» Using single and multi-dimensional arrays

» Working with .NET collections

» Using LINQ to make queries user interfaces
» Defining and implementing interfaces » Using audio files, video files and still images
» Working with enumerations » Using WPF data binding to quickly build applications

Course Description: This course provides students with hands on experience using Visual Studio to create
Windows Presentation Foundation (WPF) applications using C#. The class provides a thorough introduction
to the C# programming language, including coverage of the essentials of the C# programming language, built
in data types, operators, control structures, classes and methods, collections and exception handling.

Students then learn how to leverage the power of the .NET Framework to build WPF applications. Students
learn the basics of XAML and how to use it to describe the appearance and behavior of WPF user interfaces.
Students also learn how to use XAML resources to manage styles, triggers and control templates.

Students learn how use a variety of WPF controls to interact with users and manage data in multi-form
applications. Students explore how to leverage the power of XAML data binding. Students also learn the
basics of working with audio and images, as well as performing simple animations.

Other topics include: debugging techniques; building menus, toolbars and status bars; using the ribbon
control; reading and writing files; and deploying WPF applications. Comprehensive labs and exercises provide
the students with extensive experience creating and debugging WPF applications.

Course Prerequisites: Knowledge of fundamental XML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Windows-Presentation-Foundation-Training-Course-Using-C-Sharp.htm
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Windows Presentation Foundation Programming Using VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create VB.NET applications » Creating and deploying a WPF application
» Working with .NET data types » Working with XAML
» Creating variables with the proper scope » Writing XAML markup to create controls, define

property values and setup events

» Using the WPF layout controls to build user
interfaces

» Writing event handlers

» Using predefined dialogs

» Creating and using custom dialogs

» Using brushes, shapes and animations within WPF

» Designing and using classes

» Using control structures

» Using procedures to build complex applications
» Throwing and trapping exceptions

» Using single and multi-dimensional arrays

» Working with .NET collections

» Using LINQ to make queries user interfaces
» Defining and implementing interfaces » Using audio files, video files and still images
» Working with enumerations » Using WPF data binding to quickly build applications

Course Description: This course provides students with hands on experience using Visual Studio to create
Windows Presentation Foundation (WPF) applications using VB.NET. The class provides a thorough
introduction to the C# programming language, including coverage of the essentials of the VB.NET
programming language, built in data types, operators, control structures, classes and methods, collections
and exception handling.

Students then learn how to leverage the power of the .NET Framework to build WPF applications. Students
learn the basics of XAML and how to use it to describe the appearance and behavior of WPF user interfaces.
Students also learn how to use XAML resources to manage styles, triggers and control templates.

Students learn how use a variety of WPF controls to interact with users and manage data in multi-form
applications. Students explore how to leverage the power of XAML data binding. Students also learn the
basics of working with audio and images, as well as performing simple animations.

Other topics include: debugging techniques; building menus, toolbars and status bars; using the ribbon
control; reading and writing files; and deploying WPF applications. Comprehensive labs and exercises provide
the students with extensive experience creating and debugging WPF applications.

Course Prerequisites: Knowledge of fundamental XML syntax is helpful, but not required. Prior experience
with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/WPF-Training-Course-Using-VB-NET.htm
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Windows Presentation Foundation Programming for
Experienced C# Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating and deploying a WPF application » Using predefined dialogs

» Working with XAML » Creating and using custom dialogs

» Writing XAML markup to create controls, define » Using brushes, shapes and animations within WPF
property values and setup events user interfaces

> Uiin the WPF layout controls to build user » Using audio files, video files and still images
interfaces

» Using WPF data binding to quickly build applications
» Writing event handlers

Course Description: This course provides students with hands on experience using Visual Studio to create
Windows Presentation Foundation (WPF) applications using C#. Students should already have a working
knowledge of C#.

This course teaches students how to leverage the power of the .NET Framework to build WPF applications.
Students learn the basics of XAML and how to use it to describe the appearance and behavior of WPF user
interfaces. Students also learn how to use XAML resources to manage styles, triggers and control templates.

Students learn how use with a variety of WPF controls to interact with users and manage data in multi-form
applications. Students explore how to leverage the power of XAML data binding to build Students also learn
the basics of working with audio and images, as well as performing simple animations.

Other topics include: building menus, toolbars and status bars; using the ribbon control; reading and writing
files; and deploying WPF applications. Comprehensive labs and exercises provide the students with extensive
experience creating and debugging WPF applications.

Course Prerequisites: Knowledge of fundamental XML syntax is helpful, but not required. Prior experience
with C# is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Windows-Presentation-Foundation-Programming-Course.htm

"Instructor was well prepared and engaging.
Explained and presented material very well.
Excellent use of real world examples atf fimes."

- M.L., Bryan Texas Ufilities
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Windows Presentation Foundation Programming for
Experienced VB.NET Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating and deploying a WPF application » Using predefined dialogs

» Working with XAML » Creating and using custom dialogs

» Writing XAML markup to create controls, define » Using brushes, shapes and animations within WPF
property values and setup events user interfaces

> Uiin the WPF layout controls to build user » Using audio files, video files and still images
interfaces

» Using WPF data binding to quickly build applications
» Writing event handlers

Course Description: This course provides students with hands on experience using Visual Studio to create
Windows Presentation Foundation (WPF) applications using VB.NET. Students should already have a working
knowledge of VB.NET.

This course teaches students how to leverage the power of the .NET Framework to build WPF applications.
Students learn the basics of XAML and how to use it to describe the appearance and behavior of WPF user
interfaces. Students also learn how to use XAML resources to manage styles, triggers and control templates.

Students learn how use with a variety of WPF controls to interact with users and manage data in multi-form
applications. Students explore how to leverage the power of XAML data binding to build Students also learn
the basics of working with audio and images, as well as performing simple animations.

Other topics include: building menus, toolbars and status bars; using the ribbon control; reading and writing
files; and deploying WPF applications. Comprehensive labs and exercises provide the students with extensive
experience creating and debugging WPF applications.

Course Prerequisites: Knowledge of fundamental XML syntax is helpful, but not required. Prior experience
with VB.NET is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Windows-Communication-Foundation-Training-Courses.htm

"Excellent class. Very clear presentation
of the material by the instructor. Hands on
exercises were very helpful and provided true
understanding of the material. Very satisfied,
will look to take further classes with HOTT"

- F.D.,Paladin Labs
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Windows Presentation Foundation Programming Using .NET
Core

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating a WPF application » Enhancing the Uls with the addition of menus,
» Working with XAML toolbars and status bars
» Writing XAML markup to create controls, define > Creating and using dialog boxes
property values and setup events » Routing Events
» Using the WPF layout controls to create user » Utilizing resources in WPF applications
interfaces

Course Description: This course introduces Windows Presentation Foundation (WPF), the .NET technology
from Microsoft for building rich Windows applications. WPF includes an XML-based markup language for
defining program elements, called Extensible Application Markup Language (XAML). WPF applications can be
created using only code or a combination of code and XAML pages. This course covers the essentials of WPF,
providing an orientation to this technology and a firm foundation for creating applications in the context of
the .NET Core framework. The course utilizes Visual Studio, the C# language, and the latest versions of .NET
Core. Comprehensive hands on exercises are integrated throughout the course to reinforce learning and
develop real competency.

Windows Presentation Foundation can have a steep learning curve. This course approaches the subject in a
practical manner, introducing the student to the fundamentals of creating Windows applications using the
features of WPF. It includes coverage of traditional concepts such as controls and also newer concepts such
as XAML, flexible layout, logical resources, dependency properties, routed events, and the loosely-coupled
command architecture of WPF.

This course is designed to run on .NET Core, an open source and modular implementation of the .NET
Framework. As of .NET Core 3.0, it is now very complete and represents the future direction of .NET software
from Microsoft, although the classical .NET Frameworks will also continue to be supported.

Course Prerequisites: Previous C# programming experience is required. Knowledge of fundamental XML
syntax is helpful, but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/NET-Core-Windows-Presentation-Foundation-Course.htm
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WCF Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Studio to create C# applications » Working with enumerations
» Working with .NET data types » Service-oriented architecture

» Creating variables with the proper scope and using  » Web Services implementation
operators to build complex expressions » Binding options

> Designing and using classes » Defining service contracts
» Using control structures such as 1 £, while and for Defining data contracts

» Using procedures to build complex applications » WCF security options

» Throwing and trapping exceptions using the try » Hosting WCF services

and catch statements -~ iy
» Using single and multi-dimensional arrays pac oosmg WCF_ |n. INgs
» Managing service instances

» Working with .NET collections }
» Fault handling

» Using LINQ to make queries )
» Defining and implementing interfaces - BiCP relling eerirel

Course Description: This course provides students with hands on experience using Visual Studio to create
service-oriented applications using Windows Communication Foundation (WCF) and C#. This class provides
a thorough introduction to the C# programming language, including coverage of the essentials of the C#
programming language, built in data types, operators, control structures, classes and methods. Students then
learn how to leverage the power of the .NET Framework to build Web Service applications that interoperate
with consumer applications including other platforms and technologies.

Students will learn how to configure addresses, bindings, and service and data contracts as well as how to use
various techniques for developing endpoints to allow communication between consumer applications and the
web services provider.

The course includes coverage of instance management, fault handling, and security. Students will learn how
to use the WCF Routing Service for load balancing, content-based routing, and protocol bridging.

Comprehensive labs and exercises provide the students with experience creating both content server and
consumer applications.

Course Prerequisites: Prior experience with a scripting or programming language is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/WCF-Programming-Courses-Using-C-Sharp.htm
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WCF Programming for Experienced C# Programmers

Duration: 3 Days | Price: $1695

Students Will Learn:

» Service-oriented architecture » Hosting WCF services

» Web Services implementation » Choosing WCF bindings

» Binding options » Managing service instances
» Defining service contracts » Fault handling

» Defining data contracts » WCF routing control

» WCF security options

Course Description: This course provides students with hands on experience using Visual Studio to create
service-oriented applications using Windows Communication Foundation (WCF) and C#. Students learn how
to leverage the power of the .NET Framework to build Web Service applications that interoperate with
consumer applications including other platforms and technologies. Students will learn how to configure
addresses, bindings, and service and data contracts as well as how to use various techniques for developing
endpoints to allow communication between consumer applications and the web services provider.

The course includes coverage of instance management, fault handling, and security. Students will learn how
to use the WCF Routing Service for load balancing, content-based routing, and protocol bridging.

Comprehensive labs and exercises provide the students with experience creating both content server and
consumer applications.

Course Prerequisites: Prior experience with C# is required.
For a complete detailed course description, visit:

http://www.traininghott.com/Courses/WCF-Training-Courses.htm
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Advanced .NET Framework Programming Using C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Designing object-oriented applications that use » Using LINQ and PLINQ to make queries
class hierarchies ; ; oo
. . » Creating multithreaded applications
= Implement!ng user-'deﬂned classes . » Building and applying attributes to code elements
» Implementing .NET interfaces and custom interfaces Using reflection effectively to query metadata and
» Working with strings and StringBuilders to efficiently perform dynamic object creation

process string data » Building and using private and shared assemblies
» Using .NET collections to manage data » Using the Parallel Task Library

> Using delegates for late binding, using callback » How to fire custom events

behavior and responding to events A , : S
. . . » How to bui services and consume them from
» Working with data using ADO.NET and XML client applications

Course Description: This hands-on course examines how to utilize advanced features of C# and the .NET
Framework in order to build sophisticated, scalable, high-performing applications. The course includes
coverage of features available in .NET 2.0 through .NET 4.5. The course begins by reviewing .NET's Common
Type System, and then examines nullable types, inferred types and dynamic data. Advanced object-oriented
programming topics include auto-implemented properties, inheritance, abstract classes, sealed classes, and
generics, as well as how to implement many of the .NET interfaces in order to take advantage of .NET
functionality.

Students learn how to use synchronous and asynchronous delegates to call methods using late binding, as well
as how to use delegates to define and fire custom events and manage callbacks. The course shows how to
build multithreaded applications and synchronize access to shared resources, including the Thread and
ThreadPool classes as well as .NET 4.0's Task class and the Parallel Task Library. Coverage of the new .NET
4.5 Async and Await features is included. Students learn how to work with data in .NET's collections, as well
as how to create and use custom generic methods and collections. Database topics include how to use ADO.
NET to manipulate data in databases and how advanced ADO.NET features provide support for transaction
management, connection pooling, and the management of disconnected DataSets. Coverage includes how to
work with XML documents and make XPath queries.

The course includes the use of LINQ to make queries of data, regardless of its location. Coverage includes
using LINQ to Objects, LINQ to SQL, LINQ to DataSets and LINQ to XML, as well as how PLINQ can be used
to make efficient queries on large sets of data located in memory.

Studentslearn about .NET's support for n-tiered application development, including encapsulating functionality
in private and shared assemblies. Students also explore how to create and consume WCF services to build
distributed systems. The course includes coverage of attributes and reflection, and how to leverage attributes
and reflection to design creative, robust solutions to common design problems.

Comprehensive labs provide students with extensive experience coding with Visual Studio to practice with the
topics presented throughout the course.

Course Prerequisites: C# programming experience.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/NET-Framework-C-Sharp-Programming-Course.htm
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Advanced .NET Framework Programming Using VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Designing object-oriented applications that use » Using LINQ and PLINQ to make queries
class hierarchies ~ s ; P
g multithreaded applications

= Implement?ng user-'defined classes . » Building and applying attributes to code elements
» Implementing .NET interfaces and custom interfaces Using reflection effectively to query metadata and
» Working with strings and StringBuilders to efficiently perform dynamic object creation

process string data » Building and using private and shared assemblies
» Using .NET collections to manage data » Using the Parallel Task Library

> Using delegates for late binding, using callback » How to fire custom events

behavior and responding to events A , : S
. . . » How to bui services and consume them from
» Working with data using ADO.NET and XML client applications

Course Description: This hands-on course examines how to utilize advanced features of VB.NET and the
.NET Framework in order to build sophisticated, scalable, high-performing applications. The course includes
coverage of features available in .NET 2.0 through .NET 4.5. The course begins by reviewing .NET's Common
Type System, and then examines nullable types, inferred types and dynamic data. Advanced object-oriented
programming topics include auto-implemented properties, inheritance, abstract classes, sealed classes, and
generics, as well as how to implement many of the .NET interfaces in order to take advantage of .NET
functionality.

Students learn how to use synchronous and asynchronous delegates to call methods using late binding, as well
as how to use delegates to define and fire custom events and manage callbacks. The course shows how to
build multithreaded applications and synchronize access to shared resources, including the Thread and
ThreadPool classes as well as .NET 4.0's Task class and the Parallel Task Library. Coverage of the new .NET
4.5 Async and Await features is included. Students learn how to work with data in .NET's collections, as well
as how to create and use custom generic methods and collections. Database topics include how to use ADO.
NET to manipulate data in databases and how advanced ADO.NET features provide support for transaction
management, connection pooling, and the management of disconnected DataSets. Coverage includes how to
work with XML documents and make XPath queries.

The course includes the use of LINQ to make queries of data, regardless of its location. Coverage includes
using LINQ to Objects, LINQ to SQL, LINQ to DataSets and LINQ to XML, as well as how PLINQ can be used
to make efficient queries on large sets of data located in memory.

Studentslearn about .NET's support for n-tiered application development, including encapsulating functionality
in private and shared assemblies. Students also explore how to create and consume WCF services to build
distributed systems. The course includes coverage of attributes and reflection, and how to leverage attributes
and reflection to design creative, robust solutions to common design problems.

Comprehensive labs provide students with extensive experience coding with Visual Studio to practice with the
topics presented throughout the course.

Course Prerequisites: VB.NET programming experience.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/NET-Framework-VB-NET-Training-Course.htm
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Advanced MVC: Building Web Applications Using the ASP.NET Web API
with C#

Duration: 5 Days | Price: $2495

Students Will Learn:

» Building Responsive Applications Using Bootstrap » Creating a Service Layer Using Web API

» Using jQuery to Provide Dynamic Behavior » Consuming Web API Services Using MVC

» Using Ajax to Build Interactive MVC Applications » Building Single Page Applications with ASP.NET MVC,
» Improving MVC Views Using jQuery Ul Web APl and Angular]s

» Implementing Custom Routing Working with the > Working with NuGet
Entity Framework

Course Description: This course provides students with the skills needed to create sophisticated web
applications using advanced features of ASPNET MVC, the Entity Framework, Web API, and the popular
JavaScript libraries jQuery, jQuery UI, Bootstrap and Angular]S. Students will build several ASPNET MVC web
applications using Visual Studio during the week to reinforce the skills they learn.

The course begins with an overview of ASPNET MVC for experienced programmers and then covers the
fundamentals of responsive website design. Students then learn how to use Bootstrap with MVC to make a
web site responsive on devices from large desktop displays to small mobile devices.

Students will learn how to integrate jQuery into an MVC application to provide dynamic, client-side behavior.
They will then learn how to use jQuery's Ajax features to build more interactive MVC applications. Students
will also learn how to use jQuery Ul widgets to provide a more sophisticated user interface for their MVC
views.

The course covers use of the Entity Framework to provide a data access layer for an MVC application. The
Database First strategy is briefly examined before thorough coverage of the more configurable Code First
strategy. Students will also learn how to use the Web API to build APIs that expose services and data via HTTP.
These APIs can be used by a diverse set of clients including browsers, desktop applications and mobile
devices.

The course includes coverage of Single-Page Applications. In these types of applications, the entire page is
loaded in the browser after the initial request. All other interactions with the server utilize Ajax requests to
update the page. The service layer is implemented with the Web API.

Additional topics include: using HTML helpers to design views; creating both inline and custom HTML helpers
to encapsulate view markup; using convention-based and attribute routing to support custom routes; and use
of the NuGet packages with MVC applications.

Course Prerequisites: Prior experience building ASPNET MVC web sites. Students who are not familiar with
the ASPNET MVC or C# should take the ASP.NET MVC Programming Using C# course instead.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/MVC-Web-API-Training-Course.htm
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Advanced MVC: Building Web Applications Using the ASP.NET Web API
with VB.NET

Duration: 5 Days | Price: $2495

Students Will Learn:

» Building Responsive Applications Using Bootstrap » Creating a Service Layer Using Web API

» Using jQuery to Provide Dynamic Behavior » Consuming Web API Services Using MVC

» Using Ajax to Build Interactive MVC Applications » Building Single Page Applications with ASP.NET MVC,
» Improving MVC Views Using jQuery Ul Web APl and Angular]s

» Implementing Custom Routing Working with the > Working with NuGet
Entity Framework

Course Description: This course provides students with the skills needed to create sophisticated web
applications using advanced features of ASPNET MVC, the Entity Framework, Web API, and the popular
JavaScript libraries jQuery, jQuery Ul, Bootstrap and Angular]S. Students will build several ASPNET MVC web
applications using Visual Studio during the week to reinforce the skills they learn.

The course begins with an overview of ASPNET MVC for experienced programmers and then covers the
fundamentals of responsive website design. Students then learn how to use Bootstrap with MVC to make a
web site responsive on devices from large desktop displays to small mobile devices.

Students will learn how to integrate jQuery into an MVC application to provide dynamic, client-side behavior.
They will then learn how to use jQuery's Ajax features to build more interactive MVC applications. Students
will also learn how to use jQuery Ul widgets to provide a more sophisticated user interface for their MVC
views.

The course covers use of the Entity Framework to provide a data access layer for an MVC application. The
Database First strategy is briefly examined before thorough coverage of the more configurable Code First
strategy. Students will also learn how to use the Web API to build APIs that expose services and data via HTTP.
These APIs can be used by a diverse set of clients including browsers, desktop applications and mobile
devices.

The course includes coverage of Single-Page Applications. In these types of applications, the entire page is
loaded in the browser after the initial request. All other interactions with the server utilize Ajax requests to
update the page. The service layer is implemented with the Web API.

Additional topics include: using HTML helpers to design views; creating both inline and custom HTML helpers
to encapsulate view markup; using convention-based and attribute routing to support custom routes; and use
of the NuGet packages with MVC applications.

Course Prerequisites: Prior experience building ASPNET MVC web sites. Students who are not familiar with
the ASPNET MVC or VB.NET should take the ASP.NET MVC Programming Using VB.NET course instead.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/MVC-Web-Applications-Programming-Course.htm
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i0S Programming for iPhone® and iPad® Applications Using
Objective-C

Duration: 5 Days | Price: $2495

Students Will Learn:

» Downloading and installing Xcode from the Mac » Creating new applications in Xcode using MVC
App Store application architecture

» Objective-C Language syntax » Creating full GUI applications

» Creating new projects using Xcode templates » The Delegate code pattern

» Using if statements and switch statements to » Using a navigation view to control the flow of an
control the flow of applications application

» Designing applications using OOP principles » Using the Debug Console for exception handling

» The difference between heap and stack memory » Using NeXTStep Objects

and the uses for each » Developing interfaces for multiple platforms and
» The ARC System resolutions

Course Description: Participants in this hands-on course will learn about and gain practice developing iOS
applications for iPhone and iPad devices. Attendees will learn all the basics needed for iOS development, from
installation of the Xcode editor to the Apple approval process. The Objective-C language is presented and used
in hands on exercises to learn how it interacts with the hardware systems.

In hands on exercises, students will use built-in data views as well as create custom screens for data entry
and presentation. Students will learn to follow Apple's design recommendations to provide clean interfaces
that appropriately size to various devices and screens. The course includes coverage of scheduled background
execution to allow code to be run when the app isn't active and to schedule alerts to draw attention back to
the app. The course covers iOS7 redesigned UI controls and many of the new features for iPhone and iPad.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency. Students will create apps from the ground up, demonstrating the features of Objective-C and
serving as an introduction to developing apps for release to the App Store.

Course Prerequisites: Prior programming experience in an object-oriented language such as Java, C# or
C++.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/iOS-Objective-C-Programming-Course.htm
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Swift Programming for iPhone® and iPad® Applications

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Xcode to build iPhone and iPad apps » Creating IBActions to handle Ul events
» Working with Swift data types » Using AutoLayout to create user interfaces for
» Using Swift control structures such as if, while and multiple iOS devices
for » Using Apple's singleton and delegate design
patterns

» Creating and calling Swift functions

» Managing data using Swift arrays and dictionaries
» Designing and using Swift classes

» Understanding how ARC manages memory

» Handling run time errors in Swift

» Understanding the iOS app life cycle

» Understanding Apple's implementation of the MVC

» Creating Single View apps

» Creating Tab Bar apps

» Creating master/detail apps

» Customizing table views and table view cells
» Interacting with local files on the device

» Using Web services to manage data

design pattern > Persisting data locally using Core Data
» Using Storyboards to design user interfaces » Working with collection views
» Creating and configuring view controllers » Capturing images using the camera
» Building IBOutlets to interact with Ul widgets » Working with gesture recognizers

Course Description: In this hands on Swift 4 programming course, attendees will learn how to develop
iPhone and iPad apps using Swift and Xcode. Students begin by learning the fundamentals of the Swift
language. They will explore how to build object-oriented applications by creating Swift classes with properties,
initializers and both instance and class methods. They will see how to effectively use advanced Swift features
like generics, closures, and error handling. Students will use Storyboards to design user interfaces for iOS
apps. They study how to configure view controller classes to interact with iOS views and controls (labels, text
fields, buttons, segmented controls, switches, table views, etc.) using IBOutlets, create event handlers using
IBActions and then code events handlers. They learn how to use segues to manage transitions between views.

Features explored include configuring table views, designing details views, implementing add features, and
coding "swipe to delete". Students also learn how to implement different types of custom table view cells.
Students learn how to persist data using three different techniques: read and write local files on the device,
make asynchronous calls to Web services and parse XML data from the HTTP response, and use Core Data to
interact with local SQLite databases. Students examine how to work with images, as well use touch and
gesture recognizers to respond to complex user interactions like pinch to zoom. They learn how to use tab bar
controllers to build a multi view app. They learn about the life cycle of an iOS app and how to write code to
respond to state transitions, including scheduling code to run in background when the app isn't active.
Throughout the course, students work with the Apple's Cocoa Touch UI Framework. The course emphasizes
best programming practices. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency. Students will create iOS apps using Swift from the ground up,
demonstrating the features of Swift, iOS, and its supporting code libraries.

Course Prerequisites: Prior programming experience in an object-oriented language such as Objective-C,
Java, C# or C++.

For a complete detailed course description, visit:

www.traininghott.com/Courses/Swift-Programming-Course.htm

iPad® and iPhone® are trademarks of Apple Inc., registered in the U.S. and other countries.
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Android™ Application Development

Duration: 5 Days | Price: $2495

Students Will Learn:

» Creating Android apps for mobile devices » Responding to screen touches

» Testing apps with the Android simulator » Embedding and using SQLite databases

» Creating User Interface (Ul) layouts » Applying fonts and styles to text and images
» Handling screen rotation » Managing the activity lifecycle of apps

» Using standard widgets » Using Java libraries with apps

Course Description: This hands-on course conveys the fundamental skills necessary to deploy Android Apps
on mobile devices such as phones and tablets. Attendees will design and build a variety of Android Apps
throughout the course. Previous Java programming knowledge is not essential, but basic programming
experience is required. Java code used in the exercises is fully explained. The course emphasizes proper layout
of the user interface (UI), including how to add buttons, labels, textboxes, checkboxes, images and other
widgets to the Ul. Students will learn how to utilize Android's XML-based layout system, which builds the Ul
with containers and widgets, as well as how to set wallpapers and add menus to the Ul. Students practice with
dialog techniques including the display of popup messages.

Students also learn how to handle screen rotation, and how to define Uls so they can adjust for different
screen sizes. The course teaches students how to accept user input from keyboards (either externally attached
or from the built-in keyboard), how to use the date/time picker, and how to present users with choices using
Selection Lists. Students will learn how to add tabs to the Ul, as well as how to display HTML content using
the built-in WebKit browser. Students will learn how to program control of state changes in the Activity
Lifecycle: active, paused, stopped or dead. For instance, since Apps often run on phones, taking a call may
send an App from the active state to the paused state. Or;, if battery life is low the App may be forced into the
dead state. Student will learn how to manage Activities moving between these states so that Apps can, for
example, save inputted data before transitioning into the dead or paused state. Also related to this is the
ability for an Activity to launch Sub-Activities, which allows Apps to run processes in the background (such as
downloading files).

Coverage of data storage includes best practices for storing images and files. Student will also learn how to
embed SQLite databases in Apps, and then use these databases to store and retrieve any kind of data. The
course emphasizes Service Oriented Architecture (SOA), and students learn how to connect Apps to web
services such as Google Maps and UPS's package tracking API. In addition to using outside web services, the
course also demonstrates how to use many of a phone or tablet's built-in features such as the camera, location
service (which determines where the device is physically located), and the Accelerometer (which determines
if the device is being tilted and how fast it's being tilted). Additional topics include how to play audio and
video, and standard techniques for storage and retrieval.

Students employ the Eclipse editor and the Android Developer Tools (ADT) plugin to perform comprehensive
hands on exercises throughout the course to reinforce learning and develop real competency. Various
alternative App development environments are compared to Eclipse, including Flex, Air and PhoneGap. The
course provides students with an introduction to a variety of Android App development resources.

Course Prerequisites: Prior experience with a scripting or programming language is required. Java skills
are helpful but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Advanced-ASPNET-Using-VB-NET-AJAX-Classes.htm

Android is a trademark of Google Inc.
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Xamarin Cross-Platform Mobile Application Development

Duration: 5 Days | Price: $2495

Students Will Learn:

» Configuring a Xamarin development system » Making calls to, and processing data from, RESTful
» Xamarin.Forms vs Xamarin.Native Services

» Anatomy of a Xamarin application » How to build Xamarin.Android apps

» XAML for Xamain.Forms apps » How to build Xamarin.iOS apps

» Handling XAML events > Working with Touch

» Customizing XAML.Forms controls on the Android > Working with Location Services
and iOS » Working with Notifications

» Working with data on the local device » Using NuGet and the Xamarin Store

Course Description: In this course students will learn how to use Xamarin as a cross-platform mobile
development tool to build native Android and iOS apps using C# and a .NET code base.

Students will begin by learning how to use Xamarin.Forms to build Android and iOS apps using a single code
base. Students will learn how to use XAML to define the UI layer for all platforms. By installing the app on
both Android and iOS simulators and real test devices, they will see how the Ul renders as native controls on
each platform, thereby giving the app a native look and feel.

Coverage of XAML includes how to use XAML controls to interact with the use, how to use XAML to manage
the Ul layout, and how to connect Ul events to C# event handlers. Students will also learn how to custom the
Ul appearance of an app for a specific platform.

Students will learn how to interact with both local data stored on the device and how to communicate with,
and process data from, RESTful services using Xamarin.Forms.

Xamarin also supports Xamarin Native, which allows developers to write separate native Ul code for each
platform. In this course, students will learn how to install and configure Xamarin.Android, and then examine
Android application architectures. They will build Android applications in C# using Xamarin.Android using the
Android designers and controls.

Students will also learn how to install and configure Xamarin.iOS, and then examine native iOS application
architectures. Students will build Xamarin.iOS applications in C# using the iOS designers and controls.

This course will also examine how to work with touch, location services and notifications for both Android and
iOS devices.

Course Prerequisites: Prior experience with a scripting or programming language is required. Java skills
are helpful but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Xamarin-Training-Course.htm
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SharePoint 2016 Power User

Duration: 3 Days | Price: $1695

Students Will Learn:

» Creating and configuring Web applications, site » Managing user access to site collections, sites, lists
collections and sites and libraries

» Adding lists and libraries to sites for information » Using workflows to automate business rules
sharing and collaboration » Configuring Microsoft Office documents for co-

» Creating and managing SharePoint pages and web authoring
SEIRES » Configuring Tags & Notes and My Sites to promote a

» Configuring site collection and site navigation richer experience for end-users
SEEE » Using Business Connectivity Services to display

» Creating and configuring SharePoint site content database tables as SharePoint web content
SELEIMIEIEE » Launching basic commands using Windows

» Using views to customize SharePoint site browsing PowerShell

Course Description: This introductory hands-on course thoroughly covers out-of-the-box features of
SharePoint and how to customize these features to make the most of your SharePoint environment. The course
begins with an overview of SharePoint system architecture, then moves on to creating SharePoint Web
applications, site collections and sites. From there, students will add Web pages to sites and create navigation
solutions for users to easily locate data. Students learn how to create new sites from scratch, as well as with
built-in templates. Included are team sites, wikis, blogs, Web databases and meeting workspaces. Pages and
Web parts are then added to sites to provide greater flexibility to the way SharePoint is presented to users.

Included are techniques for using lists to promote information sharing, creating surveys, managing tasks and
projects, as well as sharing calendars. Document and file management is also covered, including content
approval, managing major and minor file versions and document checkout & check-in.

Students will learn how to use built-in workflows, as well as how to display database records on SharePoint
sites using Business Connectivity Services (BCS).

Comprehensive hands on exercises illustrate the concepts and techniques presented, and provide practice
creating common SharePoint components.

Course Prerequisites: Familiarity with Windows Server 2012 R2 or Windows 8.1 operating system
environment. Basic understanding of NTFS file and folder structure and network access.
For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SharePoint-Power-User-Training-Course.htm
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Test Driven Development (TDD), and Refactoring Legacy Code
Using C#

Duration: 4 Days | Price: $2095

Students Will Learn:

» Unit testing using NUnit and Visual Studio » Identifying and eliminating dependencies that make

» Testing code that interacts with databases code difficult to maintain and extend

; ; » Tracking code coverage and analyzing other code
> (riqrgsﬁgndgo‘?gztys eI [5G E2EES Enelor AZle metrics to improve code maintainability

» Using mocks, fakes, and stubs » Using the seam model to identify appropriate places

A . builds and check. . in the code to make changes safely
» Automating tests, builds and check-ins using a oo . _
continuous integration server » Identifying and correcting various types of code

smells
» Refactoring existing code to improve clarity, . . . . .
readabilitygand ma%ntainability P y » Using effect sketches and pinch points to identify

o ' , ) optimal places for tests Using feature sketches to
» Identifying patterns useful in TDD including the identify opportunistic refactoring
SOLID principles

Course Description: This course provides students with hands on experience learning Test Driven
Development (TDD) using NUnit and Microsoft’s Visual Studio. Students will build unit tests using mocks,
fakes, stubs and drivers, and address issues working with databases and other systems. Student will create
tests and code that will be more likely to meet and exceed requirements. Code that receives “test coverage”
will not break existing systems, because tests are passed before code is checked in.

Students will spend time working with the issues involved in refactoring legacy code, safely cutting into an
already deployed system. Students will work on looking for, or creating “seams” to more safely improve code
or add features, and work on identifying “code smells” that need attention in a productive system.

Finally, students will explore dependency issues as well as techniques to better understand and improve
complex systems.

Students will also examine TDD and refactoring legacy code in other languages like Java to gain a broader
view of options and issues working in a multi-language shop. Comprehensive labs using C# provide facilitated
hands on practice crucial to developing competence and confidence with the new skills being learned

Course Prerequisites: C# programming experience and an understanding of object-oriented design
principles. HOTT's Learning to Program with C# course or equivalent knowledge provides a solid
foundation.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Refactoring-L.egacy-Code-C-Sharp-Course.htm
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Test Driven Development (TDD), and Refactoring Legacy Code
Using Java

Duration: 4 Days | Price: $2095

Students Will Learn:

» Unit testing using JUnit » Identifying and eliminating dependencies that make
» Testing code that interacts with databases code difficult to maintain and extend

; ; » Tracking code coverage and analyzing other code
> (riqrgsﬁgndgo‘?gztys eI [5G E2EES Enelor AZle metrics to improve code maintainability

» Using mocks, fakes, and stubs » Using the seam model to identify appropriate places

A . builds and check. . in the code to make changes safely
» Automating tests, builds and check-ins using a oo . _
continuous integration server » Identifying and correcting various types of code

smells
» Refactoring existing code to improve clarity, . . . . .
readabilitygand ma%ntainability P y » Using effect sketches and pinch points to identify

o ' , ) optimal places for tests Using feature sketches to
» Identifying patterns useful in TDD including the identify opportunistic refactoring
SOLID principles

Course Description: This course provides students with hands on experience learning Test Driven
Development (TDD) using JUnit. Students will build unit tests using mocks, fakes, stubs and drivers, and
address issues working with databases and other systems. Student will create tests and code that will be more
likely to meet and exceed requirements. Code that receives “test coverage” will not break existing systems,
because tests are passed before code is checked in.

Students will spend time working with the issues involved in refactoring legacy code, safely cutting into an
already deployed system. Students will work on looking for, or creating “seams” to more safely improve code
or add features, and work on identifying “code smells” that need attention in a productive system.

Finally, students will explore dependency issues as well as techniques to better understand and improve
complex systems.

Students will also examine TDD and refactoring legacy code in other languages like C# to gain a broader view
of options and issues working in a multi-language shop. Comprehensive labs using Java provide facilitated
hands on practice crucial to developing competence and confidence with the new skills being learned.

Course Prerequisites: Java SE 5+ programming experience and an understanding of object-oriented design
principles. HOTT's Java Programming course or equivalent knowledge provides a solid foundation.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Refactoring-Legacy-Code-Java-Training-Course.htm

"Class was great and very well paced. We had
a small class size so there was a lot of detailed
explanation. Would recommend HOTT to
anyone.”

- T.C., Fidelity Investments
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SQL Programming

Duration: 3 Days | Price: $1695

Students Will Learn:

» Design normalized table structures for relational > Using set operators (UNION, INTERSECT, EXCEPT)

databases » Using DML for SELECT, INSERT, UPDATE, DELETE
» Create databases and tables » Using subqueries

> Using primary and foreign keys » Using triggers and stored procedures

> Writing SQL queries » Using aggregate functions to return totals and
» Using inner and outer joins subtotals

Course Description: This SQL programming course teaches students relational database fundamentals and
SQL programming skills. Topics covered include relational database architecture, database design techniques,
and simple and complex query skills. This class is intended for analysts, developers, designers, administrators,
and managers new to the SQL programming language. Upon completion, participants will understand SQL
functions, join techniques, database objects and constraints, and will be able to write useful SELECT, INSERT,
UPDATE and DELETE statements. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency.

Course Prerequisites: General computer knowledge. Familiarity with relational database concepts is helpful
but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SQL-Programming-Training-Course.htm

"l thought the class was very well done. |
especially appreciated the hands on labs using
computers. It was beneficial to see the code
actually execute. Hands on training is the only
way fo learn SQL."

- S.B., FYI Solutions
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Microsoft Transact-SQL Programming

Duration: 5 Days | Price: $2495

Students Will Learn:

» Design normalized table structures for relational » Using subqueries

databases » Using triggers and stored procedures
> Create databases and tables > Using a%gregate functions to return totals and
» Using primary and foreign keys subtotals
» Writing SQL queries » Programming features of T-SQL
» Using inner and outer joins » Common table expressions
» Using set operators (UNION, INTERSECT, EXCEPT) » T-SQL specific data types and functions
» Using DML for SELECT, INSERT, UPDATE, DELETE » T-SQL cursors

Course Description: This Transact-SQL programming course teaches students relational database
fundamentals and SQL programming skills in the Microsoft SQL Server environment. Topics covered include
relational database architecture, database design techniques, and simple and complex query skills. The course
also covers Microsoft-specific T-SQL programming constructs, predefined data types including XML, creation
and use of stored procedures and user-defined functions, use of cursors, updateable views, and transaction
locking.

This class is intended for analysts, developers, designers, administrators, and managers new to the SQL
programming language. Upon completion, participants will understand SQL functions, join techniques,
database objects and constraints, and will be able to write useful stored procedures and views as well as
complex queries and updates. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency.

Course Prerequisites: General computer knowledge. Familiarity with relational database concepts is helpful
but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Transact-SQL-Programming-Courses.htm

"Out of all the places | called, HOTT was the
friendliest and the MOST helpful. Everyone | talked

to or dealt with added to my pleasant experiences, e
helped walk me through the process, answered .
my questions and were very accommodating. \
Instructor was great and very knowledgeable." :
S . |
- N.V,, Medimpact Healthcare Systems \ g \
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Relational Database Design Concepts

Duration: 3 Days | Price: $1695

Students Will Learn:

» Design normalized table structures for relational » Implementing the data model with DDL
databases » Creating, modifying and dropping database objects
» Create databases and tables » Writing SQL Queries

» Using primary and foreign keys

» Using inner and outer joins
» building a logical data model

Course Description: This relational database design class develops relational database design skills and
techniques. Practical methodologies such as E-R diagrams and normalization forms are emphasized. Attention
is placed on designing for data integrity and efficiency at the same time. During hands on lab sessions students
are required to design multiple database models from business requirements and specifications. Through
hands on experience using SQL programming code to create, populate and manage relational tables, students
will experience the necessity of proper design methods and gain an in depth understanding of the link between
design, creation, and utilization. The impact of alternative designs on maintainability and database performance
is emphasized.

Course Prerequisites: General computer knowledge. Familiarity with relational database concepts is helpful
but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Relational-Database-Design-Concepts-Hands-On-Training-Course-Class-

Seminar-Keys.htm

"Fantastic instructor — obviously well-versed
and has a lot of real-world experience. Was
able to help me apply the course material to
needs at my job. Excellent instructor, excellent
class.

-J.N,, Mary T.Inc
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Microsoft SQL Server 2016 Administration

Duration: 5 Days | Price: $2495

Students Will Learn:

» Authenticating and authorizing users » Configuring security for the SQL Server agent
» Assigning server and database roles » Managing alerts and notifications

» Authorizing users to access resources » Managing SQL Server using PowerShell

» Protecting data with encryption and auditing » Tracing access to SQL Server

» Recovery models and backup strategies » Monitoring a SQL Server infrastructure

» Backing up SQL Server databases » Troubleshooting a SQL Server infrastructure
» Restoring SQL Server databases » Importing and exporting data

» Automating database management

Course Description: This five-day instructor-led course provides students who administer and maintain SQL
Server 2016 databases with the knowledge and skills to administer a SQL Server database infrastructure.

The primary audience for this course is individuals who administer and maintain SQL Server databases. These
individuals perform database administration and maintenance as their primary area of responsibility, or work
in environments where databases play a key role in their primary job.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and Transact-SQL.
Attendance at HOTT's Microsoft Transact-SQL Programming course is highly recommended although not
required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SQL-Server-2016-Training-Course.htm
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Microsoft SQL Server 2017 Administration

Duration: 5 Days | Price: $2495

Students Will Learn:

» Installing and configuring SQL Server 2017 » Automating database management

» Authenticating and authorizing users » Configuring security for the SQL Server agent
» Assigning server and database roles » Managing alerts and notifications

» Authorizing users to access resources » Tracing access to SQL Server

» Protecting data with encryption and auditing » Monitoring a SQL Server infrastructure

» Recovery models and backup strategies » Troubleshooting a SQL Server infrastructure
» Backing up SQL Server databases » Importing and exporting data

» Restoring SQL Server databases » Creating a high availability solution

Course Description: This hands-on course provides students with the knowledge and skills to administer a
SQL Server 2017 database infrastructure. You will learn how to install, configure, manage, secure, automate,
monitor, and optimize SQL Server 2017. You will also learn how to create, manage, back up, and restore
individual databases, transfer and replicate data, configure for high availability, and plan disaster recovery.

Comprehensive hands on exercises are integrated throughout to reinforce learning and develop real
competency.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Server-2017-Administration-Training-Course.htm
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SQL Server 2016 Reporting Services

Duration: 3 Days | Price: $1695

Students Will Learn:

» Installing and configuring SQL Server Reporting » Including report parameterization enabling filtering
Services by users

» Designing reports using SQL Server Data Tools » Configuring report interactivity, including drill-
(SSDT) downs, report maps and book marks

» Creating multi-dimensional, two-dimensional and » Linking to parameterized child reports via
tabular data sources and sets hyperlinks or sub-reports

» Using the Tablix object to display information in » Creating calculated fields and custom report
Tables, Matrix (pivot tables) and free form Lists formatting

» Using visualization objects to create Charts, Spark » Deploying reports to the new Reporting Services
Lines, Data Bars and Tree Maps Web Portal

» Adding images, page headers and footers and » Configuring report snapshots, caches and
report metadata subscriptions

Course Description: SQL Server Reporting Services 2016 contains significant new functionality and
improvements over its predecessors including the new Reporting Services web portal, support for mobile
reports and dashboards, an new HTML 5 rendering engine, and exiting new report design enhancements.

The three day course includes an overview of the SQL Server business intelligence architecture focusing the
role of Reporting services. All reports are developed utilizing SQL Server Data Tools (SSDT), however the new
2016 Report Designer is also introduced. Students will complete hands-on exercises creating a number of
reports including table-based, cross tabular and forms based designs. Reports utilizing the newly designed
charts, gauges, KPIs, spark lines, data bars and tree maps will be built. Exercises will incorporate the use of
report parameters and features such as drill down, interactive sorting, hyperlinks, book marks and report
maps.

Consuming data from relational, multi-dimensional and the new tabular data sources will be incorporated into
report designs. Students will become familiar with report deployment to the new Reporting Service Web
Portal (replaced Report Manager) and learn how to use portal the management tools to configure report
caches, snapshots and subscriptions. Instruction and practice in designing report security to insure protection
of enterprise data will be provided.

The student will gain experience with the new Report Services web portal, which enables publishing content
other than paginated reports, such as Excel, Power BI and build in KPIs directly from a shared data set. Finally
the student will apply custom branding of the web portal.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SQL-Server-SSRS-2016-Training-Course.htm
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SQL Server 2016 Business Intelligence Application
Development (SSRS, SSIS, SSAS)

Duration: 5 Days | Price: $2495

Students Will Learn:

» Installing and configuring SQL Server Reporting downs, report maps and book marks

Services » Linking to parameterized child reports via
» Designing reports using SQL Server Data Tools hyperlinks or sub-reports

(S5DT) » Deploying reports to the new Reporting Services
» Creating multi-dimensional, two-dimensional and Web Portal

tabular data sources and sets

» Configuring report snapshots, caches and
» Using the Tablix object to display information in subscriptions
Tables, Matrix (pivot tables) and free form Lists » Securing reports and data sources

» Using visualization objects to create Charts, Spark ; ; ;
Lines, Data Bars and Tree Maps > g;e:\cgtlTr(l)golssSIS and SSAS projects using SQL Server

» Configuring report interactivity, including drill-

Course Description: SQL Server Reporting Services 2016 contains significant new functionality and
improvements over its predecessors including the new Reporting Services web portal, support for mobile
reports and dashboards, an new HTML 5 rendering engine, and exiting new report design enhancements.
Three of the five days are reserved for SSRS.

All reports are developed utilizing SQL Server Data Tools (SSDT), however the new 2016 Report Designer is
also introduced. Students will complete hands-on exercises creating a number of reports including table-
based, cross tabular and forms based designs. Reports utilizing the newly designed charts, gauges, KPIs,
spark lines, data bars and tree maps will be built. Exercises will incorporate the use of report parameters and
features such as drill down, interactive sorting, hyperlinks, book marks and report maps.

Consuming data from relational, multi-dimensional and the new tabular data sources will be incorporated into
report designs. Students will become familiar with report deployment to the new Reporting Service Web
Portal (replaced Report Manager) and learn how to use portal the management tools to configure report
caches, snapshots and subscriptions. Instruction and practice in designing report security to insure protection
of enterprise data will be provided. The student will gain experience with the new Report Services web portal,
which enables publishing content other than paginated reports, such as Excel, Power Bl and build in KPIs
directly from a shared data set. Finally the student will apply custom branding of the web portal.

One day is reserved for SQL Server Integration Services (SSIS). Students will learn the basics of creating SSIS
packages using SQL Server Data Tools to create Extract Transform and Load solutions used to populate data
warehouses and marts. In the final day, based on a populated data warehouse they have created, students will
then learn how to develop an SQL Server Analysis Services (SSAS) multidimensional (cube) model using the
languages Multidimensional Expressions (MDX). Cubes will be customized to include Key Performance
Indicators (KPIs), Calculated Members, Named Sets, Navigational Hierarchies, and Perspectives. Also, a brief
introduction to the SSAS Tabular module will be provided.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SOQL-Business-Intelligence-2016-Training-Course.htm

1-800-413-0939 | www.traininghott.com 93


https://www.traininghott.com/Courses/SQL-Business-Intelligence-2016-Training-Course.htm

SQL Server 2016 Business Intelligence: Integration Services
and Analysis Services

Duration: 5 Days | Price: $2495

Students Will Learn:

» Structure and function of a data warehouse or data  » Bl semantic Model

TSI _ . » Learning Multidimensional Expressions (MDX)

> rDeaggr\{\{géehouse design to support enterprise » Developing SSAS Multidimensional models

» The role of SSIS within the business intelligence > Lear”'”S Data Analysis Expressions (DAX)
framework » Developing SSAS Tabular models

» Developing SSIS Extract Transform Load (ETL) » Deploying and securing Multidimensional and
processes to populate data warehouses Tabular models

» Becoming familiar with all SSIS Control Flow tasks » Implementing SSAS Data Mining models for

predictive analysis

» Consuming the Bl Semantic Model in reports and
dashboards

» Deploying SSIS projects to SSIS Catalogs

» Configuring SSIS Environments, runtime variables
and parameters

Course Description: SQL Server 2016 provides a rich environment for business intelligence development.
The focus of this five day course is to familiarize developers with the use of SQL Server Engine, SQL Server
Integration Services (SSIS) and SQL Server Analysis Services (SSAS) to create and populate data warehouses
through ETL processing and build Multidimensional and Tabular models to use and reporting data sources.

Students will learn how to design and build data warehouses and marts using SQL Server Management
Studio. In a series of exercises, students develop SSIS packages designed to maintain a data warehouse using
the Data Flow control flow task. Also demonstrated are other control flow tasks that can interact with an NTFS
file system, FTP server, execute Win32 processes, send emails, and run .NET scripts.

Based on the populated data warehouse they have created, students will then learn how to develop both
Multidimensional and Tabular SSAS models using the languages Multidimensional Expressions (MDX) and
Data Analysis Expressions (DAX). Cubes will be customized to include Key Performance Indicators (KPIs),
Calculated Members, Named Sets, Navigational Hierarchies, and Perspectives.

Students who are also interested in Reporting Services (SSRS) should consider the 3-day SQL Server 2016
Reporting Services course in addition to this course. An 8-day training pass is available for $3,690.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/SOL-Integration-Analysis-Services-2016-Training-Course.htm
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SQL Server 2017 Reporting Services

Duration: 3 Days | Price: $1695

Students Will Learn:

» Installing and configuring SQL Server Reporting » Including report parameterization enabling filtering
Services by users

» Designing reports using SQL Server Data Tools » Configuring report interactivity, including drill-
(SSDT) downs, report maps and book marks

» Creating multi-dimensional, two-dimensional and » Linking to parameterized child reports via
tabular data sources and sets hyperlinks or sub-reports

» Using the Tablix object to display information in » Creating calculated fields and custom report
Tables, Matrix (pivot tables) and free form Lists formatting

» Using visualization objects to create Charts, Spark » Deploying reports to the Reporting Services Web
Lines, Data Bars and Tree Maps Portal

» Adding images, page headers and footers and » Configuring report snapshots, caches and
report metadata subscriptions

Course Description: This course introduces Microsoft's SQL Server Reporting Services 2012 (SSRS) utility.
It begins with a discussion of the Reporting Services architecture and how to set up Reporting Services
servers. Students will install and configure Reporting Services, and perform hands-on exercises where they
create various types of reports, including basic table-based reports, parameterized reports, drilldown reports,
linked reports, sub-reports, matrix reports (pivot tables), free-form reports and reports with charts and
gauges. Students learn how to group data and add subtotals and totals to reports, as well as how to add
custom calculations using the built-in functions or using custom functions written in .NET.

Also demonstrated are all of the data sources for reports that Reporting Services supports including: SQL
Server databases, Access databases, XML files, Oracle databases, data warehouses and Analysis Services data
cubes. Report Models, and how they can support end users creating ad-hoc reports, are covered and students
practice with them in comprehensive hands on exercises. This includes a demonstration of Report Builder,
which is a free report authoring tool from Microsoft. The course ends with a complete overview of Report
Server administration, including how to deploy and secure reports, how to schedule automatic report
generation and delivery, how to backup reports, how to store previous copies of reports in history folders, and
how to maintain and troubleshoot Report Servers.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Server-2017-Reporting-Services-Training.htm
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SQL Server 2017 Business Intelligence Application
Development (SSRS, SSIS, SSAS)

Duration: 5 Days | Price: $2495

Students Will Learn:

» Installing and configuring SQL Server Reporting report metadata
Services » Including report parameterization enabling filtering
» Designing reports using SQL Server Data Tools by users
(SSDT) » Configuring report interactivity, including drill-
» Creating multi-dimensional, two-dimensional and downs, report maps and book marks
tabular data sources and sets » Linking to parameterized child reports via
» Using the Tablix object to display information in hyperlinks or sub-reports
Tables, Matrix (pivot tables) and free form Lists » Creating calculated fields and custom report
» Using visualization objects to create Charts, Spark formatting
Lines, Data Bars and Tree Maps

» Deploying reports to the Reporting Services Web
» Adding images, page headers and footers and Portal

Course Description: This hands-on course introduces the SQL Server 2017 Business Intelligence Suite,
including Reporting Services (SSRS), Integration Services (SSIS) and Analysis Services (SSAS). Students will
complete hands-on exercises creating a number of reports including table-based, cross tabular and forms
based designs. Reports utilizing charts, gauges, KPIs, spark lines, data bars and tree maps will be built.
Exercises will incorporate the use of report parameters and features such as drill down, interactive sorting,
hyperlinks, book marks and report maps.

Consuming data from relational, multi-dimensional and tabular data sources will be incorporated into report
designs. Students will become familiar with report deployment to the Reporting Service Web Portal and learn
how to use portal the management tools to configure report caches, snapshots and subscriptions. Instruction
and practice in designing report security to insure protection of enterprise data will be provided.

Students will gain experience with the Report Services Web portal, which enables publishing content other
than paginated reports, such as Excel and Power BI. Students will also learn how to include KPIs (Key
Performance Indicators) directly from a shared data set.

One day is reserved for SQL Server Integration Services (SSIS). Students will learn the basics of creating SSIS
packages using SQL Server Data Tools to create Extract Transform and Load solutions used to populate data
warehouses and marts.

In the final day, based on a populated data warehouse they have created, students will then learn how to
develop an SQL Server Analysis Services (SSAS) multidimensional (cube) model using Multidimensional
Expressions (MDX) syntax. Cubes will be customized to include Key Performance Indicators (KPIs), Calculated
Members, Named Sets, Navigational Hierarchies, and Perspectives. Also, a brief introduction to the SSAS
Tabular module will be provided.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Business-Intelligence-2017-Training-Course.htm
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SQL Server 2017 Business Intelligence: Integration Services
and Analysis Services

Duration: 5 Days | Price: $2495

Students Will Learn:

» Structure and function of a data warehouse or data  » Bl Semantic Model

TSI _ . » Multidimensional Expressions (MDX) syntax

> rDeaggr\{\{géehouse design to support enterprise » Developing SSAS Multidimensional models

» The role of SSIS within the business intelligence — Anély5|s EYPIESS O (DAYS)
framework » Developing SSAS Tabular models

» Developing SSIS Extract Transform Load (ETL) » Deploying and securing Multidimensional and
processes to populate data warehouses Tabular models

» Functionality of all SSIS Control Flow tasks » Implementing SSAS Data Mining models for

predictive analysis

» Consuming the Bl Semantic Model in reports and
dashboards

» Deploying SSIS projects to SSIS Catalogs

» Configuring SSIS environments, runtime variables
and parameters

Course Description: SQL Server 2017 provides a rich environment for business intelligence development.
The focus of this course is to familiarize developers with the use of SQL Server Engine, SQL Server Integration
Services (SSIS) and SQL Server Analysis Services (SSAS) to create and populate data warehouses through
ETL processing and build Multidimensional and Tabular models to use and reporting data sources.

Students will learn how to design and build data warehouses and marts using SQL Server Management
Studio. In a series of exercises, students develop SSIS packages designed to maintain a data warehouse using
the Data Flow control flow task. Also demonstrated are other control flow tasks that can interact with an NTFS
file system, FTP server, execute Win32 processes, send emails, and run .NET scripts.

Based on the populated data warehouse they have created, students will then learn how to develop both
Multidimensional and Tabular SSAS models using the languages Multidimensional Expressions (MDX) and
Data Analysis Expressions (DAX). Cubes will be customized to include Key Performance Indicators (KPIs),
Calculated Members, Named Sets, Navigational Hierarchies, and Perspectives.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Integration-Analysis-Services-2017-Training-Course.htm
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SQL Server 2019 Reporting Services

Duration: 3 Days | Price: $1695

Students Will Learn:

» Installing and configuring SQL Server Reporting » Configuring report interactivity, including drill-
Services downs, report maps and book marks

» Designing reports using SQL Server Data Tools » Linking to parameterized child reports via
(SSDT) hyperlinks or sub-reports

» Creating multi-dimensional, two-dimensional and » Creating calculated fields and custom report
tabular data sources and sets formatting

» Using the Tablix object to display information in » Deploying reports to the Reporting Services Web
Tables, Matrix (pivot tables) and free form Lists Portal

» Using visualization objects to create Charts, Spark » Configuring report snapshots, caches and
Lines, Data Bars and Tree Maps subscriptions

» Adding images, page headers and footers and » Securing reports and data sources

report metadata

» Including report parameterization enabling filtering
by users

Course Description: This course introduces Microsoft's SQL Server Reporting Services 2019 (SSRS) utility.
All reports are developed utilizing SQL Server Data Tools (SSDT), however Report Designer is also introduced.
Students will complete hands-on exercises creating a number of reports including table-based, cross tabular
and forms based designs. Reports utilizing charts, gauges, KPIs, spark lines, data bars and tree maps will be
built. Exercises will incorporate the use of report parameters and features such as drill down, interactive
sorting, hyperlinks, book marks and report maps.

Consuming data from relational, multi-dimensional and tabular data sources will be incorporated into report
designs. Students will become familiar with report deployment to the new Reporting Service Web Portal and
learn how to use portal the management tools to configure report caches, snapshots and subscriptions.
Instruction and practice in designing report security to insure protection of enterprise data will be provided.

The student will gain experience with the new Report Services Web portal, which enables publishing content
other than paginated reports, such as Excel and Power BI. Students will also learn how to include KPIs (Key
Performance Indicators) directly from a shared data set.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Server-2019-Reporting-Services-Training-Course.htm
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SQL Server 2019 Business Intelligence Application
Development (SSRS, SSIS, SSAS)

Duration: 5 Days | Price: $2495

Students Will Learn:

» Installing and configuring SQL Server Reporting report metadata
Services » Including report parameterization enabling filtering
» Designing reports using SQL Server Data Tools by users
(SSDT) » Configuring report interactivity, including drill-
» Creating multi-dimensional, two-dimensional and downs, report maps and book marks
tabular data sources and sets » Linking to parameterized child reports via
» Using the Tablix object to display information in hyperlinks or sub-reports
Tables, Matrix (pivot tables) and free form Lists » Creating calculated fields and custom report
» Using visualization objects to create Charts, Spark formatting
Lines, Data Bars and Tree Maps

» Deploying reports to the Reporting Services Web
» Adding images, page headers and footers and Portal

Course Description: This hands-on SQL Server 2019 course introduces the Business Intelligence Suite,
including Reporting Services (SSRS), Integration Services (SSIS) and Analysis Services (SSAS). Students will
complete hands-on exercises creating a number of reports including table-based, cross tabular and forms
based designs. Reports utilizing charts, gauges, KPIs, spark lines, data bars and tree maps will be built.
Exercises will incorporate the use of report parameters and features such as drill down, interactive sorting,
hyperlinks, book marks and report maps.

Consuming data from relational, multi-dimensional and tabular data sources will be incorporated into report
designs. Students will become familiar with report deployment to the Reporting Service Web Portal and learn
how to use portal the management tools to configure report caches, snapshots and subscriptions. Instruction
and practice in designing report security to insure protection of enterprise data will be provided.

Students will gain experience with the Report Services Web portal, which enables publishing content other
than paginated reports, such as Excel and Power BI. Students will also learn how to include KPIs (Key
Performance Indicators) directly from a shared data set.

One day is reserved for SQL Server Integration Services (SSIS). Students will learn the basics of creating SSIS
packages using SQL Server Data Tools to create Extract Transform and Load solutions used to populate data
warehouses and marts.

In the final day, based on a populated data warehouse they have created, students will then learn how to
develop an SQL Server Analysis Services (SSAS) multidimensional (cube) model using Multidimensional
Expressions (MDX) syntax. Cubes will be customized to include Key Performance Indicators (KPIs), Calculated
Members, Named Sets, Navigational Hierarchies, and Perspectives. Also, a brief introduction to the SSAS
Tabular module will be provided.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Server-2019-SSRS-SSIS-SSAS-Training-Course.htm
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SQL Server 2019 Business Intelligence: Integration Services
and Analysis Services

Duration: 5 Days | Price: $2495

Students Will Learn:

» Structure and function of a data warehouse or data  » Bl Semantic Model

TSI _ . » Multidimensional Expressions (MDX) syntax

> rDeaggr\{\{géehouse design to support enterprise » Developing SSAS Multidimensional models

» The role of SSIS within the business intelligence — Anély5|s EYPIESS O (DAYS)
framework » Developing SSAS Tabular models

» Developing SSIS Extract Transform Load (ETL) » Deploying and securing Multidimensional and
processes to populate data warehouses Tabular models

» Functionality of all SSIS Control Flow tasks » Implementing SSAS Data Mining models for

predictive analysis

» Consuming the Bl Semantic Model in reports and
dashboards

» Deploying SSIS projects to SSIS Catalogs

» Configuring SSIS environments, runtime variables
and parameters

Course Description: SQL Server 2019 provides a rich environment for business intelligence development.
The focus of this SQL Server 2019 training course is to familiarize developers with the use of SQL Server
Engine, SQL Server Integration Services (SSIS) and SQL Server Analysis Services (SSAS) to create and
populate data warehouses through ETL processing. During class, students will build Multidimensional and
Tabular models to use as reporting data sources.

Students will learn how to design and build data warehouses and marts using SQL Server Management
Studio. In a series of exercises, students develop SSIS packages designed to maintain a data warehouse using
the Data Flow control flow task. Also demonstrated are other control flow tasks that can interact with an NTFS
file system, FTP server, execute Win32 processes, send emails, and run .NET scripts.

Based on the populated data warehouse they have created, students will then learn how to develop both
Multidimensional and Tabular SSAS models using the languages Multidimensional Expressions (MDX) and
Data Analysis Expressions (DAX). Cubes will be customized to include Key Performance Indicators (KPIs),
Calculated Members, Named Sets, Navigational Hierarchies, and Perspectives.

Course Prerequisites: Familiarity with database concepts, Windows desktop navigation and software
installation techniques. Attendance at HOTT's SQL Programming course or Microsoft Transact-SQL
Programming course is highly recommended although not required.

For a complete detailed course description, visit:

https://www.traininghott.com/Courses/SQL-Server-2019-Integration-Analysis-Services-Training-Course.htm
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UNIX/Linux Fundamentals and Shell Scripting

Duration: 5 Days | Price: $2495

Students Will Learn:

» Navigating the file system » Remote access with password authentication
» Controlling file access » Working with secure shells

» File and directory naming rules and conventions » Using GNOME and KDE GUI environments

» Manipulating files and links » How to write and run shell scripts

» Controlling the Terminal » Using conditional constructs

» Working with vi » Manipulating strings

» Monitoring and controlling processes » Command-line processing

» Using command line editing » Using regular expressions

» Command substitution, quoting and escaping » String processing utilities: sed, grep and awk
» Using backup commands » Counting words, lines and characters

» Submitting and controlling print jobs » Working with compression utilities

» Communicating over the network » Writing functions

» Using telnet commands » Using the ksh and bash commands

Course Description: This hands on course provides training on standard UNIX/Linux commands and utilities
used for day to day tasks including file manipulation, program execution and control, and effective use of the
shell and desktop environments. The course presents the concepts necessary to understand the way UNIX
works as well as the system's most commonly used commands. Data manipulation utilities and shell syntax for
synthesizing command pipelines are emphasized.

Bourne shell, Bash shell and Korn shell programming techniques are introduced so students will be able to
read and modify existing shell scripts as well as create their own. Desktop environments are also introduced
from a user's perspective, including common window managers, Open Office utilities and an introduction to
configuration tools. Comprehensive hands on exercises are integrated throughout to reinforce learning and
develop real competency.

Course Prerequisites: None

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/UNIX-Linux-Training-Course.htm

"This was an exceptionally good class. The labs
were very helpful in learning the material. The
instructor was clear and although I've worked on
UNIX systems for years, this really helped me glue
some stuff together."

- J.D., Naval Surface Warfare
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Korn Shell and Bash Shell Programming

Duration: 3 Days | Price: $1695

Students Will Learn:

» How to write and run shell scripts » Counting words, lines and characters
» Using conditional constructs » Working with compression utilities

» Manipulating strings » Writing functions

» Command-line processing » Using the ksh and bash commands
» Using regular expressions » Working with UNIX I/O streams

» String processing utilities: sed, grep and awk

Course Description: This hands on Korn and Bash Shell scripting course provides a comprehensive
introduction to writing Korn and Bash shell scripts. Besides covering fundamental syntax for program flow
control, variable assignment and substitution, I/O control, and mathematical expressions, it emphasizes the
powerful features of these shells, including built-in string operators, variable typesetting/conversion, functions,
and coprocess communication and control. The creative use of standard UNIX and Linux utilities within
scripts to solve problems is stressed throughout.

The course is designed for the administrators and programmers who are developing, testing, or integrating
software on UNIX or Linux, as well as for advanced UNIX or Linux users. Both the commonalities and
differences between the Korn and Bash shells are examined, and students will have the opportunity to learn
from examples coded in both shells. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency.

Course Prerequisites: Familiarity with UNIX file system and commands

For a complete detailed course description, visit:

Course.htm

http://www.traininghott.com/Courses/Korn-Bash-Shell-Programming-Trainin

"The instructor was incredible. He clearly
explained command concepts and their
practical use. One of the best courses | have
attended!"

- D.J., Bereskin & Parr LLP
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Linux System Administration

Duration: 5 Days | Price: $2495

Students Will Learn:

» Installing a Linux operating system and configuring  » Performing backups and restoration of files

peripher.als o » Troubleshooting system problems
’ E%E%g:e'gg and modifying startup and shutdown » Analyzing and taking measures to increase system

performance
» Working with the X Windows interface
» Configuring networked file systems
» Deploying a working Web server configuration
» Sharing files with a Windows SMB protocol
» Configuring DHCP services
» Configuring DNS services
» Implementing security measures

» Setting up and maintaining basic networking
» Populating the system with users and groups

» Setting specific file permissions on directories and
regular files

» Performing maintenance on file systems
» Managing running processes
» Automating daily tasks

Course Description: This hands on Linux administration course teaches students how to install, configure
and maintain a Linux system in a networked environment. Students will not only learn to perform basic
administrative tasks such as adding and managing users, creating and maintaining file systems, developing
and implementing a security policy, and performing software installation and package management, but will
also learn to perform Linux network-related tasks, including installing and supporting SSH, NFS, Samba,
DNS, DHCP, and the Apache Web server. Comprehensive hands on exercises are integrated throughout to
reinforce learning and develop real competency.

The course includes comprehensive hands on practice installing and configuring Linux systems including
CentOS 6. Labs include adding and deleting users, backing up and restoring the system, adding/deleting
software, automating the scheduling of tasks, creating file systems, managing remote access, and installing
and tuning Samba and Apache, as well as working with modern system logging utilities such as rsyslog. Class
participants will also discuss common security issues, and be introduced to several tools, such as PAM
modules, that can help secure the operating environment. Upon completion of this course, students will be
prepared to competently maintain a Linux system in a networked business environment.

Course Prerequisites: Students should be experienced UNIX or Linux users. Knowledge of the Linux file
system and commands equivalent to attendance in the UNIX/Linux Fundamentals course is required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Linux-System-Administration-Training-Course.htm

"The instructor has extensive knowledge of
Linux and course materials and presented it very
well. | have recommended this Linux course to a

colleague who is planning to take this course in the
near future. | have attended many training courses
and feel this was the best course | have taken."

- C.N,, NEI
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C Programming

Duration: 5 Days | Price: $2495

Students Will Learn:

» Components of a C program » Returning the value of a function

» Using the C preprocessor » Declaring argument data types

» Using standard runtime libraries » ANSI function prototype syntax

» Using make to build programs » Declaring and initializing arrays and

» Working with debugger utilities multidimensional arrays

» Using data types, storage classes and scope » Using Strings and character manipulation

» Using typedef£ to make code more readable and > Declaring and instancing a structure
portable » Defining a union

» Using operators and expressions » Accessing command line arguments and

» Working with conditional and looping constructs environment variables
» Initializing a pointer » C runtime library standard 1/0 functions

» Accessing the value addressed by a pointer

Course Description: This hands on C programming course provides a comprehensive introduction to the
ANSI C language, emphasizing portability and structured design. Students are introduced to all major
language elements including fundamental data types, flow control, and standard function libraries. Thorough
treatment is given to the topics of string and character manipulation, dynamic memory allocation, standard
I/0O, macro definition, and the C runtime library. The course explains the use of aggregate structures, unions,
and pointers early on so the students can practice extensively in the hands on labs.

Structured programming constructs and varargs functions are also covered. Emphasis is given to the
processing of command line arguments and environment variables so students will be able to write flexible,
user-friendly programs. The course also includes coverage of portability tips drawn from experienced
programmers working in production environments. Comprehensive hands on exercises are integrated
throughout to reinforce learning and develop real competency.

Course Prerequisites: Understanding of fundamental programming concepts.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/C-Programming-Training-Course.htm

"The course exceeded my expectations. |
expected to get a kick start on the road to
learning C. Instead | felt | now have a solid
ground of the fundamentals and I'm ready to
dive in with both feet

- D.H., Simon Friser University
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C++ Programming for C Programmers

Duration: 4 Days | Price: $2095

Students Will Learn:

» Writing procedural programs using C++ » Using the keyword template to write generic
» Using private, public and protected keywords to functions and classes
control access to class members » Writing programs that use generic classes and

functions

» Writing programs that use algorithms and
containers of the Standard Library

» Using algorithms and containers of the Standard

» Defining a class in C++
» Writing constructors and destructors
» Writing classes with const and static class members

» Overloading operators Library to manipulate string data

» Implementing polymorphic methods in programs » Using try () blocks to trap exceptions

» Writing programs using file I/0 and string streams » Using catch () blocks to handle exceptions

> (L)intr;)%{nanipulators and stream flags to format » Defining exceptions and using throw to trigger them

Course Description: This hands on C++ training course presents a thorough introduction to object-oriented
programming in C++ for experienced C programmers. The central concepts of C++ syntax and style are
taught in the context of using object-oriented methods to achieve reusability, adaptability and reliability.
Emphasis is placed on the features of C++ that support abstract data types, inheritance, and polymorphism.
Students will learn to apply the process of data abstraction and class design.

Practical aspects of C++ programming including efficiency, performance, testing, and reliability considerations
are stressed throughout. Comprehensive hands on exercises are integrated throughout to reinforce learning
and develop real competency.

Course Prerequisites: Prior programming experience with C.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/C++-Training-Course.htm

#INCLUDE <IOSTREAM>
VSING NAMESPACE STD;
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COVT << "LINE 1 << W' << "LINE 2" << ENDL;

€COVT << Line 3", !

"The class and course contents were very well
organized and presented. Excellent instructor.
One of the best I've had. Overall, | really enjoyed
the class and feel like | have a much better
understanding of C++ and object oriented
programming.”
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C++ Programming for Non-C Programmers

Duration: 5 Days | Price: $2495

Students Will Learn:

» Defining variables and building expressions using » Writing programs using file I/0 and string streams
the variety of data types available in C/C++ » Using manipulators and stream flags to format

» Using the control structures available in C/C++ output

» Defining functions with/without parameters and call  » Using the keyword template to write generic
those functions functions and classes

» Using pointer syntax and understand the purpose » Writing programs that use generic classes and
of pointers functions

» Writing procedural programs using C++ » Writing programs that use algorithms and

» Using private, public and protected keywords to containers of the Standard Library
control access to class members » Using algorithms and containers of the Standard

Library to manipulate string data
» Using try() blocks to trap exceptions
» Using catch () blocks to handle exceptions
» Defining exceptions and using throw to trigger them

» Defining a class in C++

» Writing constructors and destructors

» Writing classes with const and static class members
» Overloading operators

» Implementing polymorphic methods in programs

Course Description: This hands on C++ programming course provides an accelerated introduction to the
most essential syntactical components of the C and C++ languages on the first day, prior to four days of focus
on object-oriented programming with C++. The course begins by introducing the built in data types,
fundamental control constructs, and rich expression operator repertoire common to both C and C+.

The remainder of the course teaches object-oriented programming using features of C++, congruent with the
C++ for C Programmers course. Comprehensive hands on exercises are integrated throughout to reinforce
learning and develop real competency.

Course Prerequisites: Prior programming experience, though not necessarily in C or C++. Some prior
knowledge of basic C syntax is helpful but not required.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/C++-Programming-Training-Course.htm

"l was very happy with the course. | learned what
| wanted to about C++ and the exercises helped
reinforce my learning. The instructor was very
helpful and having a knowledgeable person to
ask gquestions to was an invaluable resource.”

- J.M.,, Agilent Technologies
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Critical Thinking for the 21st Century

Duration: 28 Hours | Price: $1495

Students Will Learn:

» The importance of critical thinking skills for 21st the omnipresence of bias, and ways to identify
century workers reliable news sources

» How to identify and analyze credible facts and » Techniques for gathering reliable information; the
evidence to reach sound conclusions importance of expertise

» How to identify and differentiate between sound » The many cultural and behavioral biases that lead to
thinking, magical thinking, pseudoscience, poor decision-making by even the most exceptional
skepticism, and cynicism and brilliant minds

» To analyze and create graphical and tabular » Basic statistical terminology and how to analyze
visualizations statistical information, including distribution,

» The basics of memory and information retrieval, deviation, correlation, causation and the law of large

how the way the brain functions affects our numbers
thinking, and why it is so difficult and unusual for » The nature of logic and argument, premises and
people to change their minds when confronted by conclusions, deductive and inductive arﬁuments,
new evidence validity and soundness, strong and weak

» The many types of propaganda encountered in arguments, and formal and informal fallacies
virtually all communications, and how to filter » How to make a decision, including the Franklin
through it to find actual useful information analysis, cost-benefit analyses, weighted decision

analysis, expected value analysis and multi-criteria

» The role of journalism, the importance of accuracy, decision analysis

Course Description: Critical Thinking is the process of performing analysis that is objective, logical, logically
consistent, fair, and informed by evidence, in order to form a judgment, make a decision, or determine the
truth. Critical Thinking for the 21st Century teaches students to think critically in their personal and
professional lives.

The Critical Thinking training course teaches practical skills and provides practical experience to individuals
who need to develop competence and/or refine expertise in the thought processes necessary for success in
the 21st century service- and information-based economy.

The Critical Thinking skills course teaches and provides practice in making logical arguments, as well as
assessing, weighing and analyzing evidence. We discuss the ways in which brain biology affects memory and
decision-making, how emotions often muddle our thinking, whether or not we are aware of these emotions,
and how to work around these challenges. We examine how techniques of persuasion and propaganda affect
our thinking, often more than we know, and what we can do to counteract such effects. We address the
problem of obtaining accurate, reliable and unbiased information from the news media and other sources of
information, and we explore the subject of understanding and presenting visual information.

Each Critical Thinking training course module is self-contained, so, while students are generally best
served if they complete the entire course, students and enterprises may opt to eschew any material that is
judged to be unnecessary or irrelevant to them.

Course Prerequisites: A high school education, GED, or equivalent experience. Familiarity with basic
computer functions (sending and receiving email, using a web browser, running apps, downloading apps) is
helpful but not required.

For a complete detailed course description, visit:

Course.htm

https://www.traininghott.com/Courses/Critical-Thinking-Trainin
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Introduction to Visual Basic 6.0

Duration: 5 Days | Price: $2495

Students Will Learn:

» Using Visual Basic's form designer to create user » Reading and writing files, output to printers and use
interfaces the Windows Registry

» Writing Visual Basic code in modules and classes » Connecting to databases to insert, delete and edit

» Creating dialogs, menus, windows and use Windows records
common dialogs » Testing and debug Visual Basic programs

» Creating SDI and MDI applications » Using exception-handling techniques to develop

» Developing modular, reusable Visual Basic code and fault-tolerant, reliable programs
forms

Course Description: This hands on Visual Basic training course provides a thorough introduction to the use
of Visual Basic 6. The main goal of the course is to enable the participant to create business applications with
Visual Basic that utilize multi-tier application design strategy for maintainability and reusability. The hands on
exercises are focused on solving commonly encountered business problems. The course introduces the Visual
Basic Integrated Development Environment (IDE) and its wealth of development tools. Students will learn to
build effective user interfaces with Visual Basic controls, forms, and other GUI components. The Visual Basic
language is covered in detail.

Students will learn the use of the debugging and testing tools available in Visual Studio. Database access is
introduced, using Visual Basic's ADO Control and data-aware components like the Data Grid and Data
Environment Designer. The course includes an introduction to object-oriented programming techniques, and
using the Packaging and Deployment tool to deliver completed applications to end users.

This course provides thorough coverage of the use of Visual Basic 6.0 using Visual Studio 98. Students
requiring coverage of Visual Basic.NET using Visual Studio 2005 and later, should attend either the Learning
to Program with VB.NET or Windows Forms Programming Using Visual Basic.NET course instead.

Course Prerequisites: Basic computer skills and familiarity with Microsoft Windows.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Visual-Basic-6-Programming-Course.htm

"The small classroom environment made me feel
comfortable enough to ask lots of questions. The
labs and examples were clear and good hands
on experience. | like the fact that | got to save my
lab work and take it home with me."

- A.L., Exxon Mobil
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Project Management

Duration: 4 Days | Price: $2095

Students Will Learn:

> Testing the value proposition affirmed through » Developing a project management plan
formal project management practices » Creating baselines to measure project health

» Surveying best practices across the generic project
management lifecycle (starting, organizing/planning, > Eéﬁgg&?ﬁg?ﬁjgﬁgng VBB IR LElTEies

carrying out the work, ending the project) ,
» [dentif mg the approFrlate project development > Determ'”'”g Gy reqwrements .
lifecycle (e.g. waterfall, agile) » Understanding the business case and project

» Understanding the primary elements of the project Just.|f|'cat|on .
charter and how charters enhance project success » Defining project and product scope

» Describing the project manager role and primary » Developing customer acceptance criteria
areas of responsibility » Deconstructing project deliverables in order to plan
» Producing and leveraging organizational project and execute project work
knowledge » Evaluating competing time and cost estimating
» Distinguishi § appropriate metrics for measuring, approaches
reporting and planning » Developing better scheduling practices
> Evaluating and applying appropriate levels of » Sequencing work flow and project management
stakeholder engagement activities for maximum efficiency

Course Description: Students will broaden their awareness of formal project management practices
through classroom lecture combined with discussion and learning activities. The course promotes the
application of proven practices by providing a more structured approach to project management. Participants
are encouraged to use current project management challenges for class discussion. The discussions and
learning activities enable the student to apply immediate solutions to real-time project management
challenges. The project management course is appropriate for newer and experienced project professionals
affording students both fundamental and intermediate training. The course focus is on project management
processes and as such applies to every domain. The course is aligned with the Project Management Institute’s
Project Management Body of Knowledge Guide Sixth Edition (PMBOK® Guide 6th Edition). As such, the
course touches on predictive, incremental and adaptive project development methodologies. The learning
objectives include distinguishing the 49 processes detailed in the PMBOK® Guide 6th Edition which are
widely recognized as defining best practices for most projects much of the time. PMBOK® is a registered
trademark of the Project Management Institute, Inc.

The PMI® (Project Management Institute (PMI) is a leading source of project management certifications. This
course does not include the cost of any PMI credential. Qualified students are encouraged to pursue
credentialing opportunities by visiting the PMI website. Please visit the PMI website for details on certification,
certification testing centers and PDU requirements. This class does provide 28 hours of formal project
management education needed for PMI certifications such as Project Management Professional (PMP)® and
Certified Associate in Project Management (CAPM)® as well as earning PDU's required for maintaining PMI
certification. PMI®, CAPM® and PMP® are registered trademarks of the Project Management Institute, Inc.

Course Prerequisites: This course is designed for project managers, team members, and senior managers
looking to acquire a firm grasp of specific steps in the project management process.

For a complete detailed course description, visit:

http://www.traininghott.com/Courses/Project-Management-Training-Course.htm

"PMI", "PMP", "PMBOK",and "CAPM" are trademarks of Project Management Institute, Inc.
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Call Today to Register

1-800-413-0939 or register online www.traininghott.com/Register.php

Contact Us

Hands On Technology Transfer

14 Fletcher Street
One Village Square, Suite 8
Chelmsford, MA 01824

E-mail:

customer-service@traininghott.com

Phone:
800-413-0939
978-250-4299

Fax: ‘
978-250-4372

115

Satisfaction Guaranteed

» Multiple, convenient training locations

» Task-oriented, competency-based course
design

» Instructors with extensive experience
» A cost-effective, total solution

» Superior customer service

» At least 50% lab time

» Small class size

We Build
Competence

GUARANTEED

50% Hands
On Labs

Save Today with Training Passes!

» Save 22% with the 2 Course Pass - $4290
» Save 30% with the 3 Course Pass - $5790
» Save 36% with the 4 Course Pass - $7090
» Save 40% with the 5 Course Pass - $8290
» Save 43% with the 6 Course Pass - $9490

If you are interested in taking a 5-day course
and 3-day course, HOTT also offers an 8-day
training pass for $3590.
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